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Documentation Updates
The title page of this document contains the following identifying information:

l Software Version number, which indicates the software version.

l Document Release Date, which changes each time the document is updated.

l Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using themost recent edition of a document, go
to:

http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign in. To register for an HP Passport
ID, go to:

http://h20229.www2.hp.com/passport-registration.html

Or click theNew users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support
service. Contact your HP sales representative for details.
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Support
Visit the HP Software Support Online web site at:

http://www.hp.com/go/hpsoftwaresupport

This web site provides contact information and details about the products, services, and support
that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and
efficient way to access interactive technical support tools needed tomanage your business. As a
valued support customer, you can benefit by using the support web site to:

l Search for knowledge documents of interest

l Submit and track support cases and enhancement requests

l Download software patches

l Manage support contracts

l Look up HP support contacts

l Review information about available services

l Enter into discussions with other software customers

l Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also
require a support contract. To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html

To findmore information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp
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Welcome to this Tutorial
Welcome to HP Application Lifecycle Management (ALM). ALM empowers IT tomanage the core
application lifecycle, from requirements through deployment, granting application teams the crucial
visibility and collaboration needed for predictable, repeatable, and adaptable delivery of modern
applications.

This tutorial is a self-paced guide that instructs you how to use the ALM application to organize and
manage all phases of the application lifecycle. To successfully complete this tutorial, you should
perform the tutorial in the order in which the information is presented.

Note: To learn how to work with the HP ALM Performance Center Edition, refer toHP ALM
Performance Center Quick Start.

How This Tutorial is Organized
This tutorial contains the following lessons:

Chapter Description

"Introducing
HP ALM" on page 16

Introduces you to the application lifecycle management process, and
familiarizes you with the ALM user interface and the sampleMercury
Tours Web site.

"Specifying
Releases and
Cycles" on page 28

Shows you how to define releases and cycles andmonitor their progress
and quality.

"Specifying
Requirements" on
page 32

Shows you how to define requirements, view the requirements tree, and
convert requirements to tests.

"Planning Tests" on
page 44

Shows you how to create a test plan tree, define test steps, define test
configurations, link test configurations to requirements, and automate
manual tests.

"Running Tests" on
page 64

Shows you how to define test sets, schedule test runs, and runmanual
and automated tests.

"Adding and
Tracking Defects" on
page 110

Shows you how to add new defects, update defects, andmanage
defects.

"Alerting on
Changes" on page
124

Shows you how to keep track of changes made to your requirements,
tests, and defects as you perform your project testing.

"Analyzing ALM
Data" on page 130

Shows you how tomonitor the application lifecycle management process
by creating reports and graphs.
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Chapter Description

"Creating Libraries
and Baselines" on
page 158

Shows you how to create libraries and baselines, and how to compare
baselines to track changes in your project.

"Customizing
Projects" on page
166

Shows you how to set up project users, and how to create project fields
and lists.

"Conclusion" on
page 182

Summarizes the ALM application lifecycle management process and
suggests the steps to consider for each phase.

Before You Begin
Towork with this tutorial, consider the following specifications:

Specification Description

ALM Editions HP ALM is also available in several editions which provide subsets of ALM
functionality —HP ALM Essentials Edition, HP Quality Center Enterprise
Edition, and HP ALM Performance Center Edition. This tutorial assumes that
you are working in HP ALM Edition or HP Quality Center Enterprise Edition.
Some of the lessons and exercises in this tutorial are not applicable if you are
working in HP ALM Essentials Edition. To determine which edition you are
using, contact your ALM site administrator.

Note: If you are working with the HP ALM Performance Center Edition,
refer toHP ALM Performance Center Quick Start.

ALM_Demo
Project

l The demo project is available with the ALM 11.52 installation DVD and is
obtained by importing the ALM_Demo.qcp file using Site Administration. For
more information, refer to theHP Application Lifecycle Management
Installation and UpgradeGuide.

l To ensure that you get the same results as the ones specified in this tutorial,
make sure that you work on a new copy of the ALM_Demo project. For more
information, contact your ALM site administrator.

l By default, the demo project is version control enabled. This tutorial assumes
that your demo project is version control enabled. For more information on
version control, refer to theHP Application Lifecycle Management User
Guide.

Mercury
Tours

l Mercury Tours is a sample application that simulates aWeb-based site for
reserving flights, hotel rooms, car rentals, cruises, and vacation deals.

l Mercury Tours is installed during the installation of ALM on a server machine.
For more information, refer to theHP Application Lifecycle Management
Installation and UpgradeGuide.
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Specification Description

HP QuickTest
Professional

l To run the automated tests in this tutorial, QuickTest Professional must be
installed.

l To integrate ALM with QuickTest Professional, youmust download and
install the HP QuickTest Professional add-in and the HP Quality Center
Connectivity add-in from the HP Application Lifecycle Management Add-ins
page. For more information on ALM add-ins, refer to theHP Application
Lifecycle Management Installation and UpgradeGuide.

HP Sprinter l To runmanual tests in this tutorial, you can useManual Runner, HP Sprinter,
or both. For enhanced functionality and a variety of tools to assist in the
manual testing process, runmanual tests with Sprinter.

l To run tests with Sprinter, download and install the Sprinter add-in from the
HP Application Lifecycle Management Add-ins page. For more information
on ALM add-ins, refer to theHP Application Lifecycle Management
Installation and UpgradeGuide.

ALM Help
The ALM Help is an online help system that describes how to use ALM. You can access the
ALM Help in the following ways:

l Click Documentation Library in the ALM Helpmenu to open the ALM Help home page. The
home page provides quick links to themain help topics.

l Click Help on this page in the Helpmenu to open the ALM Help to the topic that describes the
current page.

ALM Help Guides
The ALM Help consists of the following guides and references, available online, in PDF format, or
both. PDFs can be read and printed using Adobe Reader, which can be downloaded from the Adobe
Web site (http://www.adobe.com).

Reference Description

Using the ALM Help Explains how to use the Help and how it is organized.

What’s New? Describes the newest features in the latest version of ALM.

To access, select Help > What's New.

Movies Short movies that demonstrate themain product features.

To access, select Help > Movies.

Readme Provides last-minute news and information about ALM.

HP ALM (11.52)Page 10 of 184

Tutorial
Welcome to this Tutorial

http://www.adobe.com/


HP Application
Lifecycle
Management (ALM)
Guides Description

HP ALM User
Guide

Explains how to use ALM to organize and execute all phases of the
application lifecycle management process. It describes how to specify
releases, define requirements, plan tests, run tests, and track defects.

HP ALM
Administrator
Guide

Explains how to create andmaintain projects using Site Administration,
and how to customize projects using Project Customization.

HP ALM Lab
Management Guide

Explains how to use LabManagement to manage lab resources used for
functional and performance testing on remote hosts.

HP ALM Tutorial A self-paced guide teaching you how to use ALM tomanage the
application lifecycle management process.

HP ALM
Installation and
Upgrade Guide

Describes the installation and configuration processes for setting up
ALM Server, and the project upgrade process.

HP ALM Business
Views Microsoft
Excel Add-in User
Guide

Explains how to install and use the Business Views Microsoft Excel
Add-in to create and configure business view Excel reports.

Business Process
Testing User Guide

Explains how to use Business Process Testing to create business
process tests.

HP ALM
Performance
Center Guides Description

HP ALM
Performance
Center Quick
Start

A self-paced guide giving the Performance Center user a high level overview
of creating and running performance tests.

HP ALM
Performance
Center Guide

Explains to the Performance Center user how to create, schedule, run, and
monitor performance tests. Explains to the Performance Center
administrator how to configure andmanage Performance Center projects.

HP ALM
Performance
Center
Installation
Guide

Describes the installation processes for setting up Performance Center
Servers, Performance Center Hosts and other Performance Center
components.
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HP ALM Best Practices Guides Description

HP ALM Agile Testing Best Practices
Guide

Provides best practices for implementing agile
testing principles.

HP ALM Business Process Models
Best Practices Guide

Provides best practices for working with the
Business Models module.

HP ALM Database Best Practices
Guide

Provides best practices for deploying ALM on
database servers.

HP ALM Entities Sharing Best
Practices Guide

Provides best practices for sharing entities.

HP ALM Project Planning and
Tracking Best Practices Guide

Provides best practices for managing and tracking
releases.

HP ALM Project Topology Best
Practices Guide

Provides best practices for structuring projects.

HP ALM Upgrade Best Practices
Guide

Provides methodologies for preparing and planning
your ALM upgrade.

HP ALM Versioning and Baselining
Best Practices Guide

Provides best practices for implementing version
control and for creating baselines.

HP ALM Workflow Best Practices
Guide

Provides best practices for implementing workflows.

HP ALM Performance Center
Best Practices Guides Description

HP Performance Centers of
Excellence Best Practices

Provides best practices for successfully building and
operating Performance Centers of Excellence.

HP Performance Monitoring
Best Practices

Provides best practices for monitoring the performance of
applications under test.

HP ALM API
References Description

HP ALM
Project
Database
Reference

Provides a complete online reference for the project database tables and
fields.

HP ALM Open
Test
Architecture
API Reference

Provides a complete online reference for the ALM COM-based API. You can
use the ALM open test architecture to integrate your own configuration
management, defect tracking, and home-grown testing tools with an ALM
project.
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HP ALM API
References Description

HP ALM Site
Administration
API Reference

Provides a complete online reference for the Site Administration COM-based
API. You can use the Site Administration API to enable your application to
organize, manage, andmaintain ALM users, projects, domains, connections,
and site configuration parameters.

HP ALM REST
API Reference
(Technology
Preview)

Provides an online reference for the ALM REST-based API. You can use the
REST API to access and work with ALM data.

HP ALM COM
Custom Test
Type
Developer
Guide

Provides a complete online guide for creating your own testing tool and
integrating it into the ALM environment using native COM development tools.

HP ALM .NET
Custom Test
Type
Developer
Guide

Provides a complete online guide for creating your own testing tool and
integrating it into the ALM environment using a combination of DCOM and
.NET classes.

Topic Types
The content in the abovementioned ALM guides is organized by topics. Threemain topic types are
in use: Concepts, Tasks, andReference.

Topic Type Description Usage

Concepts Background, descriptive, or conceptual
information.

Learn general information
about what a feature does.
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Topic Type Description Usage

Tasks Instructional Tasks. Step-by-step
guidance to help you work with the
application and accomplish your goals.

Task steps can be with or without
numbering:

l Numbered steps. Tasks that are
performed by following each step in
consecutive order.

l Non-numbered steps. A list of self-
contained operations that you can
perform in any order.

l Learn about the overall
workflow of a task.

l Follow the steps listed in a
numbered task to complete
a task.

l Perform independent
operations by completing
steps in a non-numbered
task.

Use-case Scenario Tasks. Examples of
how to perform a task for a specific
situation.

Learn how a task could be
performed in a realistic
scenario.

Reference General Reference. Detailed lists and
explanations of reference-orientedmaterial.

Look up a specific piece of
reference information relevant
to a particular context.

User Interface Reference. Specialized
reference topics that describe a particular
user interface in detail. Selecting Help on
this page from the Helpmenu in the product
generally opens the user interface topics.

Look up specific information
about what to enter or how to
use one or more specific user
interface elements, such as a
window, dialog box, or wizard.

Troubleshooting
and Limitations

Troubleshooting and Limitations.
Specialized reference topics that describe
commonly encountered problems and their
solutions, and list limitations of a feature or
product area.

Increase your awareness of
important issues before
working with a feature, or if
you encounter usability
problems in the software.

Additional Online Resources
The following additional online resources are available from the Helpmenu:

Resource Description

Troubleshooting
& Knowledge
Base

Opens the Troubleshooting page on the HP Software Support Web site
where you can search the Self-solve knowledge base. ChooseHelp >
Troubleshooting & Knowledge Base. The URL for this Web site is
http://h20230.www2.hp.com/troubleshooting.jsp.
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Resource Description

HP Software
Support

Opens the HP Software Support Web site. This site enables you to browse
the Self-solve knowledge base. You can also post to and search user
discussion forums, submit support requests, download patches and updated
documentation, andmore. ChooseHelp > HP Software Support. The URL
for this Web site is www.hp.com/go/hpsoftwaresupport.
l Most of the support areas require that you register as an HP Passport

user and sign in. Many also require a support contract.

l To findmore information about access levels, go to:
http://h20230.www2.hp.com/new_access_levels.jsp

l To register for an HP Passport user ID, go to:
http://h20229.www2.hp.com/passport-registration.html

HP Software
Web site

Opens the HP SoftwareWeb site. This site provides you with themost up-
to-date information on HP Software products. This includes new software
releases, seminars and trade shows, customer support, andmore. Choose
Help > HP Software Web site. The URL for this Web site is
www.hp.com/go/software.

Add-ins Opens the Add-ins page, which offers integration and synchronization
solutions with HP and third-party tools.

Tools Opens the ALM Tools add-ins page, which offers integration and
synchronization solutions with HP and third-party tools that are installed with
ALM on the ALM Server.

ALM Extension Guides
Extensions provide added functionality to HP ALM. If you have a license for an ALM extension, you
can utilize the added functionality by enabling the extension on a per project basis. For more details
on enabling extensions, refer to theHP Application Lifecycle Management Administrator Guide.

To view the list of extensions available with ALM 11.52, or to download documentation for ALM
extensions, visit the HP ALM Add-ins page, available from the HP Application Lifecycle
Management Add-ins page (Help > Add-ins).
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Chapter 1: Introducing HP ALM
ALM helps you organize andmanage all phases of the application lifecycle management process,
including defining releases, specifying requirements, planning tests, executing tests, and tracking
defects.

In this lesson, you will learn about:

The Application Lifecycle Management Process 17

Starting ALM 17

ALMWindow 20

TheMercury Tours SampleWeb Site 23
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The Application Lifecycle Management
Process

The application lifecycle management process with ALM includes the following phases:

Phase Description

Release
Specifications

Develop a release-cycle management plan to help youmanage application
releases and cycles efficiently.

Requirement
Specifications

Define requirements tomeet your business and testing needs.

Test Planning Based on the project requirements, you can build test plans and design tests.

Test
Execution

Create a subset of the tests in your project designed to achieve specific test
goals. Execute scheduled tests to diagnose and resolve problems.

Defect
Tracking

Submit defects and track their repair progress.

Throughout the process, you can generate reports and graphs to assist you in “go/no-go” decisions
about your application readiness.

Starting ALM
Start ALM from yourWeb browser using the HP ALM URL.

To start ALM:

1. Verify tutorial prerequisites.

Before you begin the lessons in this tutorial, verify that you have the appropriate prerequisites.
For more information, see "Before You Begin" on page 9.

2. Open the Application Lifecycle Management Options window.

Open yourWeb browser and type your ALM URL:

http://<ALM server name>[<:port number>]/qcbin. Contact your system administrator if you do
not have the correct path.

The HP Application Lifecycle Management Options window opens.
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3. Open ALM.

Each time ALM is run, it checks the version. If it detects a newer version, it downloads the
necessary files to your machine.

Note:

n Windows XP and 7: If you do not have administrator privileges on your machine, and a
Security Warning displays, click Don’t Install. You will be redirected to the Install
screen.

n If file downloads are prohibited by your browser, you can install these files by using the
HP ALM Client MSI Generator Add-in on theMore HP Application Lifecycle
Management Add-ins page. For more information on add-ins, refer to theHP Application
Lifecycle Management Installation Guide.

The ALM Login window opens.
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4. Type a user name and authenticate.

In the Login Name box, type alex_alm.

Skip thePassword box. A password was not assigned.

Click theAuthenticate button. ALM verifies your user name and password and determines
which domains and projects you can access.

5. Log in to the project.

In theDomain list, select DEFAULT.

In theProject list, select ALM_Demo. If more than oneALM_Demo project is listed, contact
your ALM site administrator to determine which project to use.

Click the Login button.

The first time you run ALM, theWelcome page opens. From theWelcome page, you can
directly access the ALM documentation and featuremovies.

When you log in to a project, the ALMmain window opens and displays themodule in which
you were last working. In the upper-right corner of the window, the domain name, project name,
and your user name are displayed.
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ALM Window
In this exercise, you will explore the ALMmodules and their common elements. You will also learn
how to navigate the online help.

To explore the ALM window:

1. Explore the ALMmodules.

Click the following sidebar buttons:

Button Description

Includes the followingmodules:

n Analysis View. Enables you to create graphs and reports.

n Dashboard View. Enables you to create dashboard
pages, in which you can view multiple graphs in a single
display.

Includes the followingmodules:

n Releases. Enables you to define releases and cycles for
the applicationmanagement process.

n Libraries. Enables you to define libraries to track changes
in your project, reuse entities in a project, or share entities
across multiple projects.

Includes the followingmodules:

n Requirements. Enables you tomanage requirements in a
hierarchical tree-structure. Requirements can be linked to
other requirements, tests, or defects.

n Business Models. Enables you to import business
process models, and test the quality of themodels and
their components. Access to this module is dependent on
your ALM license.
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Button Description

Includes the followingmodules:

n Test Resources. Enables you tomanage test resources
in a hierarchical tree-structure. Test resources can be
associated with tests.

n Business Components. Depending on your ALM license,
youmay also have access to the Business Components
module. This module enables subject matter experts to
drive the quality optimization process using Business
Process Testing, the HP test automation solution. For
more information, refer to theHP Business Process
Testing User Guide.

n Test Plan. Enables you to develop andmanage tests in a
hierarchical tree-structure. Tests can be linked to
requirements and defects.

n Test Lab. Enables you tomanage and run tests. After
running tests, you can analyze the results.

n Test Runs. Enables you to view the results of executed
tests.

Enables you to add defects, determine repair priorities, repair
open defects, and analyze the data.

2. Explore the common ALM elements.

All the ALMmodules have common elements. For example, click theDefects sidebar button.

Each of the ALMmodules contains the following key elements:

n ALM common toolbar. This toolbar is accessible from all modules and contains the
following buttons:

Button Description

Navigates to your previous/next view in ALM.

Includes commands that you can run from each of the ALM
modules.

Enables you to open the HP Application Lifecycle Management
Documentation Library and additional online resources. It also
enables you to display version information for each ALM client
component. For more information, see "ALM Help" on page 10
and "Additional Online Resources" on page 14.

<domain, project,
user>

Details of the current domain, project, and user.

HP ALM (11.52)Page 21 of 184

Tutorial
Chapter 1: Introducing HP ALM



Button Description

Logs you out of your current project and returns you to the
Application Lifecycle Management Login window.

n Module menu bar. Displays themenus from which you select commands in the current
ALMmodule.

n Module toolbar. This is located below themenu bar. It contains buttons for frequently used
commands in the current ALMmodule.

3. View ALM help topics.

a. To view the help topic of the Defects module window, click theDefects sidebar button. The
Defects module is displayed. ChooseHelp > Help on this page. The help topic opens in
a separate window.

b. To view the Application Lifecycle Management Documentation Library home page, in the
Contents tab, click Home. The Documentation Library home page opens.

The Documentation Library consists of guides and references, available online, in PDF
format, or both.

c. Under theContents tab, click theUsing The ALM Help link. The HP ALM Help section
links to the key tasks, movies, and other resources.

d. Click theClose ( ) button.
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The Mercury Tours Sample Web Site
Mercury Tours is the sampleWeb application used in this tutorial. It simulates aWeb-based
application for reserving flights, hotel rooms, car rentals, cruises, and vacation deals. Before
continuing with the tutorial, familiarize yourself with this application.

To explore Mercury Tours:

1. Open theMercury Tours application.

Open a separate instance of yourWeb browser, and type this URL: http://<ALM Platform
server name>[<:port number>]/mtours

TheMercury Tours home page opens.

2. Register with Mercury Tours.
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a. Click Register. The Register page opens.

b. UnderUser Information, enter any user name and password, and confirm your password.
(Other information is not required.)

c. Click Submit. Mercury Tours confirms your registration.

3. Log on toMercury Tours.
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a. Click Sign-on. The Sign-on page opens.

b. Type your registered user name and password. Click Submit. The Flight Finder page
opens.
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4. Reserve a flight.

Follow the on-screen instructions to reserve a flight.

5. End your Mercury Tours session.

Click Sign-off.
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Chapter 2: Specifying Releases and
Cycles

You begin the application lifecycle management process by specifying releases and cycles. A
release represents a group of changes in one or more applications that will be available for
distribution at the same time. Each release can contain a number of cycles. A cycle represents a
development andQA cycle based on the project timeline. The releases and cycles have defined
start and end dates.

You can organize and track your upcoming releases by defining a hierarchical release tree
containing releases and cycles. In this lesson, you will add a release to an existing release tree, and
then add cycles to the release.

Note: This lesson is not available for HP ALM Essentials Edition.

In this lesson, you will learn about:

Defining Releases and Cycles 29

Viewing Releases and Cycles 30
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Defining Releases and Cycles
In this exercise, you will define a release and then add cycles to the release. Releases and cycles
each have start dates and end dates. The date range for a cycle must be contained within the date
range of the release.

To define a release and its cycles:

1. Open the ALM_Demo project.

If theALM_Demo project is not already open, log in to the project. For more information, see
"Starting ALM" on page 17.

2. Display the Releases module.

On the ALM sidebar, under Management, select Releases.

3. Create a new release folder.

a. In the releases tree, select the root Releases folder. Click theNew Release Folder
button. The New Release Folder dialog box opens.

b. In theRelease Folder Name box, type Service Packs.

c. Click OK. TheService Packs release folder is added to the releases tree.

d. In theDescription box in the right pane, type the following description for the release
folder: This folder contains service pack releases.

4. Add a release.

a. In the releases tree, make sure that the new Service Packs release folder is selected.

b. Click theNew Release button. The New Release dialog box opens.

c. In theName box, type Service Pack 1.

d. In theStart Date box, click the down arrow and select yesterday’s date. In theEnd Date
box, click the down arrow and select the date twomonths from today’s date.

e. In theDescription box, type the following description for the release: This release is the
first service pack release.

f. Click OK. TheService Pack 1 release is added to theService Packs release folder.

5. Add a cycle to the release.

a. In the releases tree, make sure that theService Pack 1 release is selected.

b. Click theNew Cycle button. The New Cycle dialog box opens.

c. In theName box, type Cycle 1 - New Features.

d. In theStart Date box, click the down arrow and select yesterday’s date. In theEnd Date
box, click the down arrow and select the date amonth from today’s date.

e. In theDescription box, type the following description for the cycle: This cycle tests new
features added for this service pack.

f. Click OK. TheCycle 1 - New Features cycle is added to theService Pack 1 release.
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6. Add a second cycle to the release.

a. In the releases tree, right-click theService Pack 1 release and chooseNew Cycle. The
New Cycle dialog box opens.

b. In theName box, type Cycle 2 - Full.

c. In theStart Date box, click the down arrow and select the date onemonth and a day from
today’s date. In theEnd Date box, click the down arrow and select the date twomonth
from today’s date.

d. In theDescription box, type the following description for the cycle: This cycle fully tests
all application features.

e. Click OK. TheCycle 2 - Full cycle is added to theService Pack 1 release.

Viewing Releases and Cycles
You can view the status of your releases and cycles. ALM shows a high-level overview of the
progress of the currently selected release or cycle. It also shows the number of defects opened
over the course of the currently selected release or cycle. You can also view the number of
outstanding defects.

In this exercise you will learn how to display the progress and graphs of a selected release and
cycle.

To view releases and cycles:

1. Make sure theReleasesmodule is displayed.

On the ALM sidebar, underManagement, select Releases.

2. Display the Progress graph for the Service Pack 1 release.

In the releases tree, select theService Pack 1 release, located in theService Packs release
folder. In the right pane, click theStatus tab. The Progress tab is displayed by default.
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The Progress tab displays the progress of the release based on requirement coverage, elapsed
and remaining time, and actual and remaining test instances to run. As you have not yet
created requirements or tests, the information in the Coverage Progress graph indicates 0%
progress.

3. Display the Progress graph for a cycle.

In the releases tree, select theCycle 1 - New Features cycle, located in theService Pack 1
release.

In the right pane, click theProgress tab. You can see that the information available is similar to
that available for the release, but at the cycle level. As in the case of the release, you have not
yet created requirements and tests, therefore the information in the Coverage Progress graph
indicates 0% progress.
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Chapter 3: Specifying Requirements
Requirements describe in detail what needs to be solved or achieved tomeet the objectives of your
application under development.

You define the requirements in ALM by creating a requirements tree in the Requirements module.
This is a hierarchically graphical representation of your requirements. You can group and sort
requirements in the tree, monitor the progress in meeting requirements, and generate detailed
reports and graphs.

In this lesson, you will create requirements in an existing requirements tree. You will then assign
the requirements to a cycle in the releases tree. You will also learn how to convert requirements to
tests.

In this lesson, you will learn about:

Defining Requirements 33

Viewing Requirements 37

Converting Requirements to Tests 39
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Defining Requirements
In this exercise, you will define requirements for testing the functionality of reserving cruises in
Mercury Tours.

Note: If you are using HP ALM Essentials Edition, multiple requirement types are not
supported. In addition, fields and commands related to cycles and releases are not available.

To define a requirement:

1. Open the ALM_Demo project.

If theALM_Demo project is not already open, log in to the project. For more information, see
"Starting ALM" on page 17.

2. Display the Requirements module.

a. On the ALM sidebar, underRequirements, select Requirements.

b. ChooseView > Requirements Tree to display requirements in a tree.

3. Select theMercury Tours Application requirement.

Expand theRequirements root requirement and select theMercury Tours Application
requirement.
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4. Create a new requirement.

a. Click theNew Requirement button. The New Requirement dialog box opens.

b. In theName box, type Cruise Reservation.

c. In theRequirement Type box, select Functional. Each requirement belongs to a
requirement type. The requirement type to which a requirement belongs determines which
fields are available for the requirement. Your project administrator canmodify existing
types and add new types.

Note: If you are using HP ALM Essentials Edition, ignore this step.

d. In the Details tab, type or select the following:

Priority: 4-Very High

Product: Mercury Tours Web Site

e. Click Submit.

f. Click Close to close the New Requirement dialog box. TheCruise Reservation
requirement is added to the requirements tree under theMercury Tours Application
requirement.

5. Add the Cruise Search child requirement.

a. In the requirements tree, make sure that the new Cruise Reservation requirement is
selected.
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b. Click theNew Requirement button to add a requirement below Cruise Reservation. The
New Requirement dialog box opens.

c. In theName box, type Cruise Search.

d. In theRequirement Type box, select Functional.

Note: If you are using HP ALM Essentials Edition, ignore this step.

e. In the Details tab, type or select the following:

Priority: 4-Very High

Product: Mercury Tours Web Site

f. Click Submit.

g. Click Close to close the New Requirement dialog box. TheCruise Search requirement is
added as a child of theCruise Reservation requirement.

6. Add the Cruise Booking child requirement.

a. In the requirements tree, make sure that theCruise Reservation requirement is selected.

b. Click theNew Requirement button to add a requirement below Cruise Reservation. The
New Requirement dialog box opens.

c. In theName box, type Cruise Booking.

d. In theRequirement Type box, select Functional.

Note: If you are using HP ALM Essentials Edition, ignore this step.

e. In the Details tab, type or select the following:

Priority: 4-Very High

Product: Mercury Tours Web Site

f. Click Submit.

g. Click Close to close the New Requirement dialog box. TheCruise Booking requirement
is added as a child of theCruise Reservation requirement.

7. Assign the requirements to a cycle.

Note: If you are using HP ALM Essentials Edition, ignore this step.

a. In the requirements tree, select Cruise Reservation.

b. ChooseRequirements > Assign to Cycle. The Select Cycles dialog box opens.
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c. Locate theService Packs releases folder. UnderService Pack 1, select the check box for
theCycle 1 - New Features cycle.

d. Click OK to close the releases tree.

e. Click Yes to assign the requirement and its sub-requirements to the cycle.

8. Assign additional requirements to a cycle.

Note: If you are using HP ALM Essentials Edition, ignore this step.

a. In the requirements tree, underMercury Tours Application, select Online Travel
Booking Services.

b. ChooseRequirements > Assign to Cycle. In the Select Cycles dialog box, locate the
Service Packs releases folder. UnderService Pack 1, select the check box for theCycle
1 - New Features cycle. Click OK.

c. Version Control: If the Check Out dialog box opens, click OK.

d. Click Yes to assign the requirement and its sub-requirements to the cycle.
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Viewing Requirements
You can change the way requirements are displayed. In this exercise, you will learn how to zoom in
and out of the requirements tree, rearrange the requirement order, and display and filter
requirements in the requirements grid.

To view requirements:

1. Make sure theRequirementsmodule is displayed.

a. If the Requirements module is not displayed, on the ALM sidebar, underRequirements,
select Requirements.

b. ChooseView > Requirements Tree to display requirements in a tree..

2. Zoom in and out of the requirements tree.

a. Select Cruise Reservation in the requirements tree.

b. To zoom in, click Zoom and choose Zoom In. The requirements tree displays only the
child requirements of Cruise Reservation.

c. To reverse the zoom-in action and display the entire requirements tree, click Zoom and
choose Zoom Out To Root.

3. Rearrange the order of requirements in the requirements tree.

ALM adds requirements to the requirements tree in order of creation. To rearrange the order,
select theCruise Search requirement and click theMove Down button. The Cruise Search
requirement moves down below the Cruise Booking requirement.

4. View requirements in the requirements grid.

ChooseView > Requirements Grid to display requirements in a flat nonhierarchical view.
Each line in the grid displays a separate requirement.

5. Define a filter to view requirements created on a specific date.
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a. Click the Filter button. The Filter dialog box opens.

b. For theCreation Date field, click the Filter Condition box. Click the down arrow button.
The Select Filter Condition dialog box opens, displaying today’s date in the calendar.
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c. Select the date on which you added requirements.

d. Click OK to close the Select Filter Condition dialog box.

e. Click OK to apply your chosen filter.

f. The Requirements Grid displays the requirements you added.

Converting Requirements to Tests
After you create the requirements tree, you can use the requirements as a basis for defining your
test plan tree in the Test Planmodule.

You can use the Convert to Tests wizard to assist you when designing your test plan tree. The
wizard enables you to convert selected requirements or all requirements in the requirements tree to
subjects or tests in the test plan tree.

In this exercise, you will convert theCruise Reservation requirement to a subject in the test plan
tree, and the child requirements of Cruise Reservation to tests in the Cruise Reservation subject
folder.
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To convert a requirement to a test:

1. Make sure theRequirementsmodule is displayed.

If the Requirements module is not displayed, on the ALM sidebar, underRequirements, select
Requirements.

2. Select a requirement.

a. ChooseView > Requirements Tree to display requirements in a tree.

b. In the requirements tree, select Cruise Reservation.

3. Open the Convert to Tests wizard.

Choose Requirements > Convert to Tests. The Step 1 dialog box opens.

4. Choose an automatic conversionmethod.

Select the second option, Convert lowest child requirements to tests, to convert the
selected requirement to a subject folder, and its subrequirements to tests.

5. Start the conversion process.

a. Click Next to begin converting the requirements. When the conversion process is
complete, the results are displayed in the Step 2 dialog box.
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b. Click Next. The Step 3 dialog box opens.

6. Choose the destination subject path.

a. In theSubject box, click the down arrow button. A dialog box displaying the test plan tree
opens.

b. In the test plan tree, select theCruises subject.
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c. Click OK to close the Select Destination Subject dialog box. TheSubject box now
indicates this test plan.

7. Finalize the conversion process.

Click Finish. The Required Test Fields dialog box opens and displays themissing required
fields of the Cruise Booking test.

8. Specify the required test fields.

a. Select the following:

Level: Basic

Priority: 4-Very High

Reviewed: Reviewed

b. Click OK. The Required Test Fields dialog box reopens and displays themissing required
fields of the Cruise Search test.

c. Select the same values entered for the Cruise Booking test. Click OK.

d. Click OK to close the Convert to Tests wizard.

9. View the tests in the test plan tree.

a. On the ALM sidebar, under Testing, select Test Plan.

b. ChooseView > Test Plan Tree to display the test plan tree.

c. ExpandCruises. The test plan tree displays Cruise Reservation underCruises.

d. ExpandCruise Reservation. The test plan tree displays theCruise Booking andCruise
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Search tests.
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Chapter 4: Planning Tests
After you define your requirements, you need to determine your testing goal and outline the strategy
for achieving your goal.

After you determine your testing goal, you build a test plan tree, which hierarchically divides your
application into testing units, or subjects. For each subject in the test plan tree, you define tests that
contain steps. For each test step, you specify the actions to be performed on your application and
the expected result.

ALM enables you to use the same test to test different use-cases, each with its own test
configuration. Each test configuration uses a different set of data. You define the data by adding
test parameter values for each test configuration. A test parameter is a variable that can be
assigned a value.

When you create a test, a single test configuration with the same name as the test is created
simultaneously. You can create as many additional test configurations as needed.

It is essential that the tests in your test plan comply with your requirements. To help ensure
compliance throughout the application lifecycle management process, add coverage between tests
and requirements. For finer granularity, you add coverage between test configurations and
requirements.

In this lesson, you will learn about:

Developing a Test Plan Tree 45

Designing Test Steps 47

Defining Test Parameters 49

Defining Test Configurations 52

Creating and Viewing Coverage 54

Creating Coverage 55

Analyzing Coverage 57

Copying Test Steps 60

Generating Automated Test Scripts 61
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Developing a Test Plan Tree
The typical application is too large to test as a whole. The Test Planmodule enables you to divide
your application according to functionality. You divide your application into units, or subjects, by
creating a test plan tree. The test plan tree is a graphical representation of your test plan, displaying
your tests according to the hierarchical relationship of their functions. After you define subjects in
the tree, you decide which tests to create for each subject, and add them to the tree.

In this exercise, you will add a subject and a test to the test plan tree in the Test Planmodule.

To develop a test plan tree:

1. Open the ALM_Demo project.

If theALM_Demo project is not already open, log in to the project. For more information, see
"Starting ALM" on page 17.

2. Display the Test Planmodule.

On the ALM sidebar, under Testing, select Test Plan.

3. Add a subject folder to the test plan tree.

a. Select theSubject folder and click theNew Folder button. The New Test Folder dialog
box opens.

b. In the Test Folder Name box, type Payment Methods. Click OK. The new folder is added
to the test plan tree.

c. In theDescription tab in the right pane, type a description of the subject: This folder
contains tests that verify the payment methods.

4. Add a test to the subject folder.

a. Select the Payment Methods folder and click theNew Test button. The New Test dialog
box opens.
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b. In the Test Name box, type a name for the test: Credit Cards.

c. In the Type box, selectMANUAL to create amanual test.

d. In theDetails tab, select the following:

Level: Basic

Reviewed: Not Reviewed

Priority: 4-Very High

e. In theDescription tab, type a description for the test: The test verifies credit card types.

f. Click OK. The new test is added to the test plan tree under the Payment Methods folder.
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Designing Test Steps
After you add a test to the test plan tree and define basic test information, you define test steps—
detailed, step-by-step instructions that specify how to execute the test. A step includes the actions
to be performed on your application and the expected results. You can create test steps for both
manual and automated tests. For manual tests, you complete test planning by designing the test
steps. Using your plan, you can begin test execution immediately. For automated tests, you create
automated test scripts using HP testing tools, custom testing tools, or third-party testing tools.

In this exercise, you add test steps to theCredit Cards test. This test verifies the credit card type
used to book a flight.

To design a test step:

1. Make sure the Test Planmodule is displayed.

If the Test Planmodule is not displayed, on the ALM sidebar, under Testing, select Test Plan.

2. Display theCredit Cards test.

Expand thePayment Methods folder, and select theCredit Cards test.

3. Open the Design Step Details dialog box.

a. Click theDesign Steps tab.

b. Click theNew Step button. TheDesign Step Details dialog box opens.
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In theStep Name box, a step name is displayed. The default name is the sequential
number of the test step.

4. Define the first test step.

In the Design Step Details dialog box, type the following:

Step Name: Step 1: Log in toMercury Tours.

Description:

1. Enter URL.

2. Log in.

Expected Result: User is logged in toMercury Tours.

5. Close the Design Step Details dialog box.

Click OK.

6. Add the remaining test steps.

For each of the following test steps, click theNew Step button to open the Design Step Details
dialog box, type the required information, and click OK to close the Design Step Details dialog
box:

Step Name Description Expected Result

Step 2: Select a flight
destination.

a. Click the Flights button.

b. Enter flight details and
preference.

c. Click Continue.

Flight details and
preference are entered.

Step 3: Enter departure
and return flight.

a. Select departure and return
flights.

b. Click Continue.

The flights are selected.

Step 4: Enter passenger
details.

Enter first name, last name, and
meal preference.

Passenger details are
entered.

Step 5: Enter credit card
details.

a. Enter credit card type.

b. Enter credit card number.

c. Enter expiration date.

Credit card details are
entered.

Step 6: Enter addresses. Enter billing and delivery
addresses.

Addresses are entered.

Step 7: Complete the
purchase.

Click Secure Purchase. Purchase completed.

Step 8: Log out. Click the LogOut button. User logs out of Mercury
Tours.

The Design Steps tab displays the design steps.

HP ALM (11.52)Page 48 of 184

Tutorial
Chapter 4: Planning Tests



Defining Test Parameters
To increase the flexibility of your tests, you can add parameters to your tests. This enables you to
run the same test repeatedly with different data each time.

When working with amanual test, you can add parameters to the design steps from within the test
or you can add parameters by calling them from other tests. This is useful if you have common
steps you often want to perform as part of other tests.

When working with an automated test, you can define parameters for a test script from within the
test or you can load parameters from a shared test resource file.

When defining a test configuration, you define data by setting test parameter values for each test
configuration.

In "Designing Test Steps" on page 47, you defined steps for theCredit Cards test. In this exercise,
you will add parameters to enhance this test.

To define test parameters:

1. Display the Parameters tab for the Credit Cards test.

a. In the test plan tree, expand thePayment Methods folder, and select theCredit Cards
test.

b. Click theParameters tab.

2. Add a parameter.
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a. Click theNew Parameter button. The Test Parameter Details dialog box opens.

b. Type the following:

Parameter Name: Credit card type.

Default Value: American Express, Visa, or MasterCard.

c. Click OK to close the Test Parameter Details dialog box. The parameter is added to the
Parameters tab.

3. Add an additional parameter.

a. Click theNew Parameter button. The Test Parameter Details dialog box opens.

b. Type the following:

Parameter Name: Credit card number.

Default Value:1111-2222-3333-4444.

c. Click OK to close the Test Parameter Details dialog box. The parameter is added to the
Parameters tab.

4. Assign parameters to the test steps.

a. Click theDesign Steps tab.

b. Click theDescription box of Step 5.

c. Place the cursor after 1. Enter credit card type and click the Insert Parameter button. The
Parameters dialog box opens.
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d. Select theCredit Card Type parameter. Click OK.

e. Place the cursor after 2. Enter credit card number and click the Insert Parameter button.
The Parameters dialog box opens. Select theCredit Card Number parameter. Click OK.

f. The parameters are added to your design step.
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Defining Test Configurations
You can reuse a test to test different use-cases. For each use-case you create a test configuration
that uses a different data set. When working with amanual test, the data set of a test configuration
contains values for your defined test parameters. When working with a QuickTest Professional or a
business process test, the data set can use an external test resource file.

In the following exercise, you will create a test configuration for each of the following credit cards:
American Express, Visa, andMasterCard. You will then define the actual parameter values to be
used when running these instances.

To define test configurations:

1. Display the Test Configurations tab for the Credit Cards test.

a. In the test plan tree, expand thePayment Methods folder, and select theCredit Cards
test.

b. Click the Test Configurations tab.

By default, ALM created the Credit Cards test configuration.

2. Rename the test configuration name to American Express.

a. UnderName, click Credit Cards. TypeAmerican Express.

b. UnderDescription, type: Test configuration for American Express.
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3. Assign data to the test configuration.

a. Click theData tab.

b. UnderActual Value, click the top cell. Click the arrow and click in the box. Type: 2222-
3333-4444-5555. Click OK.

c. UnderActual Value, click the second cell. Click the arrow and click in the box. Type:
American Express. Click OK.

4. Add a new test configuration for Visa.

a. Click theNew Test Configuration button. The New Test Configuration dialog box opens.

b. Type the following:

Name: Visa

Description: Test configuration for Visa.

c. Click OK. The test configuration is added to the Test Configuration tab.

d. Make sure the Visa test configuration is selected.

e. Click theData tab. UnderActual Value, click the top cell. Click the arrow and click in the
box. Type: 3333-4444-5555-6666. Click OK.

f. UnderActual Value, click the second cell. Click the arrow and click in the box. Type:
Visa. Click OK.

g. Select theCredit Card Type parameter. Click OK.

5. Add a new test configuration for MasterCard.

a. Click theNew Test Configuration button. The New Test Configuration dialog box opens.

b. Type the following:

Name: MasterCard

Description: Test configuration for MasterCard.

c. Click OK. The test configuration is added to the Test Configuration tab.

d. Make sure theMasterCard test configuration is selected.

e. Click theData tab. UnderActual Value, click the top cell. Click the arrow and click in the
box. Type: 4444-5555-6666-7777. Click OK.
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f. UnderActual Value, click the second cell. Click the arrow and click in the box. Type:
MasterCard. Click OK.

6. Version Control: Check in the test configurations.

Check in the test and its test configurations. In the test plan tree, rightclick theCredit Cards
test, and select Versions > Check In. Click OK to confirm.

Creating and Viewing Coverage
It is essential that the tests in your test plan comply with your requirements. To help ensure
compliance throughout the application lifecycle management process, you can add coverage
between your tests and requirements. You can also add coverage between test configurations and
requirements.

You can create coverage from the Test Planmodule and the Requirements module. A test or a test
configuration can cover more than one requirement, and a requirement can be covered by more than
one test or test configuration.

In these exercises, you will learn about the following:

Creating Coverage 55

Analyzing Coverage 57
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Creating Coverage
In this exercise, you will create theCredit Cards requirement and then create coverage by
associating it to theCredit Cards test.

To create coverage:

1. Display the Requirements module.

a. On the ALM sidebar, underRequirements, select Requirements.

b. ChooseView > Requirement Details. The Requirement Details view is displayed.

2. Create the Credit Card requirement.

a. Select theMercury Tours Application folder.

b. Click theNew Folder button. In the New Requirement Folder dialog box, type: Payments.
Click OK.

c. Select thePayments folder and click theNew Requirement button. The New
Requirement dialog box opens.

d. In theName box, type Credit Cards.

e. In theRequirement Type box, select Functional.

Note: If you are using HP ALM Essentials Edition, ignore this step.

f. Click Submit. Click Close. The new requirement is added to the requirements tree.

3. Display the Test Coverage tab.

a. In the requirements tree, make sure that theCredit Cards requirement is selected.

b. In the right pane, click the Test Coverage tab.

4. Display the Test Plan Tree pane.

Click theSelect Tests button to show the test plan tree on the right.
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5. Select the Credit Cards test in the test plan tree.

a. In the Test Plan Tree pane, expand thePayment Methods folder, and select theCredit
Cards test.

b. If the Test Configurations pane is not displayed, click theShow button on the bottom of the
pane. Under the Test Configurations pane, you can see that the test contains three test
configurations.

6. Add the test to the coverage grid.

In the Test Plan Tree pane, click theAdd to Coverage button. TheCredit Cards test is added
to the coverage grid.

7. Display the Test Configuration Status tab.

Click the Test Configuration Status tab.

The Test Configuration Status tab shows the associated test configurations and their status.
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Tip: To add selected configurations of a test to the requirement's test coverage, add
coverage from the Test Configurations pane.

8. Hide the test plan tree.

Click theClose button above the tests plan tree.

9. Version Control: Check in the Payments folder and the Credit Cards requirement.

a. In the test plan tree, right-click thePayments folder, and select Versions > Check In.
Click OK to confirm.

b. Right-click theCredit Cards requirement, and select Versions > Check In. Click OK to
confirm.

Analyzing Coverage
After you create test coverage, you can use the Coverage Analysis view in the Requirements
module to analyze the breakdown of child requirements according to test coverage.

In this exercise, you will analyze theApplication Client System requirement.

To analyze test coverage:

1. Make sure that the Requirements module is displayed.

If the Requirements module is not displayed, on the ALM sidebar, underRequirements, select
Requirements.

2. Display the requirements tree in Coverage Analysis view.

ChooseView > Coverage Analysis. The Coverage Analysis view is displayed.
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3. Display the Application Client System requirement in Coverage Analysis view.

a. If any filters are applied, click the Filter arrow and chooseClear Filter/Sort. Click Yes to
confirm.

b. Under theMercury Tours Application requirement, expand theApplication Client
System requirement and its children.

In the Coverage Analysis column, you can see graphically the number of child
requirements that have a direct cover status and those that are not yet covered.

4. Display coverage analysis for the Application Client System requirement.

Right-click theApplication Client System requirement, and chooseCoverage Analysis.
The Coverage Analysis dialog box opens.

5. Display the child requirements with a “Failed” status.

Click the red Failed area of the graph. The child requirements with a “Failed” status are listed.
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6. Display test coverage for the requirement.

a. Click theShow Test Coverage link to extend the Coverage Analysis dialog box and
display the Test Coverage Chart.
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This pie chart graphically displays the full test coverage for the requirement, grouped
according to test status.

b. Click thePassed section of the chart to open the Tests Coverage dialog box and display
the list of tests with the selected status. Close the Test Coverage dialog box.

7. Close the Coverage Analysis dialog box.

Click theClose button.

Copying Test Steps
You can copy steps from another test in the same project or from a different project. In this
exercise, you will copy the test steps from theHTML Page Layout test and paste them into a
newly created test.

To copy a test step:

1. Display the Test Planmodule.

a. On the ALM sidebar, under Testing, select Test Plan.

b. If the test plan tree view is not displayed, select View > Test Plan Tree.

2. Create a new test.

a. In the test plan tree, expand theMercury Tours Site folder.

b. Select theHTML Pages folder and click theNew Test button. The New Test dialog box
opens.

c. In the Test Name box, type a name for the test: New HTMLPage Layout.

d. In the Type box, selectMANUAL to create amanual test.

e. In the Details tab, select the following:

Level: Basic

Reviewed: Not Reviewed

Priority: 4-Very High

f. Click OK. The new test is added to the test plan tree under theHTML Pages folder.

3. Display the Design Steps tab for the HTMLPage Layout test.

a. In theHTML Pages folder, select theHTML Page Layout test.

b. Click theDesign Steps tab.

4. Select the steps that you want to copy.

Position themouse pointer in the gray sidebar on the left. Themouse pointer changes to a
pointing hand. Select all rows.
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5. Copy the selected steps.

Click theCopy Steps button.

6. Paste the steps into the New HTMLPage Layout test.

a. In the test plan tree, select theNew HTML Page Layout test.

b. In theDesign Steps tab, click thePaste Steps button. The test steps are copied to the
Design Steps tab.

Generating Automated Test Scripts
Test planning involves deciding which tests to automate. If you choose to execute tests manually,
the tests are ready for execution as soon as you define the test steps. If you choose to automate
tests, you can generate test scripts and complete them using other HP testing tools (for example,
QuickTest Professional).

Consider these issues when deciding whether to automate a test.

Do Automate Do Not Automate

Tests that run with each new version of your application to check
the stability of basic functionality across the entire application
(regression tests).

Tests that are executed only
once.
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Do Automate Do Not Automate

Tests that usemultiple data values for the same operation (data-
driven tests).

Tests that require immediate
execution.

Tests that are runmany times (stress tests) and tests that check
amulti-user client/server system (load tests).

Tests that check how easy
the application is to use
(usability tests).

Tests that do not have
predictable results.

In this exercise, you will generate a QuickTest Professional test script for theAddress Options
test.

Note: For prerequisites to working with a QuickTest Professional test, see "Before You Begin"
on page 9.

To generate an automated test script:

1. Make sure the test plan tree view is displayed.

If the test plan tree view is not displayed, select View > Test Plan Tree.

2. Locate the Address Options manual test.

a. Select theSubject folder at the root of the test plan tree and chooseEdit > Find. The Find
dialog box opens.

b. InValue To Find, type Book.

c. In theSearch for, select Folders.

d. Click Find. The Search Results dialog box opens and displays a list of possible matches.

e. Double-click the Flight Reservation\Book Flight folder to highlight the folder in the test
plan tree. Click Close to close the Search Results dialog box.

f. In the test plan tree, expand theBook Flight folder and select theAddress Options test.

3. Display the Design Steps tab.

In the right pane, click theDesign Steps tab.

4. Generate a test script.

a. Click theGenerate Script button.

b. ChooseQUICKTEST_TEST to generate a QuickTest Professional test.

c. Version Control: If a check out message box opens, click OK.

The steps in theAddress Options test are used to create the automated test script.

5. View the test script.

a. Click the Test Script tab.
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b. To display andmodify your test script in QuickTest Professional, click the Launch
QuickTest Professional button.
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Chapter 5: Running Tests
Throughout the application lifecycle management process, you can run automated andmanual
tests to locate defects and assess the quality of your application.

You start by creating test sets and choosing which tests to include in each set. A test set contains
a subset of the tests in an ALM project designed to achieve specific test goals.

After you define test sets, you can begin to execute your tests. Some tests can be run
automatically and some can be runmanually.

When you run a test automatically, ALM opens the selected testing tool, which runs the test, and
imports the test results to ALM.

When you run a test manually, you execute the test steps you defined in test planning. You pass or
fail each step, depending on whether the actual results match the expected output.

If you are usingALM Edition, you can use server-side execution to reserve testing resources for
automated tests. Server-side execution occurs on remote testing hosts, can be scheduled or
immediate, and does not require user intervention.

ALM enables you to control the execution of tests in a test set by setting conditions and scheduling
the date and time for executing your tests.

After test execution, you can use ALM to view and analyze the results of your tests.

In this lesson, you will learn about:

Test Set Types 65

Defining Test Sets 66

Defining a Functional Test Set 66

Defining a Default Test Set 70

Adding Tests to a Test Set 75

Adding Tests to a Functional Test Set 75

Adding Tests to a Default Test Set 76

Defining a Build Verification Suite 79

Setting Schedules and Conditions for Test Runs 81

Running Tests 87

Running Tests in a Functional Test Set 87

Running a Functional Test Set in the Test Labmodule 88

Scheduling a Functional Test Set in the Timeslots Module 90

Running Tests in a Default Test Set Manually 91

Running with Sprinter 92

Running with Manual Runner 96
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Running Tests in a Default Test Set Automatically 100

Viewing and Analyzing Test Results 101

Viewing Test Results in the Test Runs Module 101

Viewing Functional Test Set Results in the Test Set Runs Tab 101

Viewing Test Results in the Test Runs Tab 102

Viewing Test Results in the Test Instance Properties Dialog Box 103

Viewing Test Coverage 105

Viewing Coverage Progress 107

Test Set Types
After you design tests in the Test Planmodule, you create a test sets tree in the Test Labmodule. A
test sets tree enables you to organize your testing needs by grouping test sets in folders and
organizing them in different hierarchical levels in the Test Labmodule. You assign each test set
folder to a cycle. This enables you to group together test sets that will be run during the same cycle
and analyze the progress of the cycle as you run your tests.

When defining a test set, you add instances of your selected tests to the test set. Each test
instance contains a defined test configuration.

ALM provides the following types of test sets:

l Functional test sets include automatic tests that check the application under test functions as
expected. Tests in a Functional test set are scheduled in a timeslot to run on a server, without
requiring user supervision. Available for: ALM Edition only.

l Default test sets can include automatic andmanual tests, and are used to check that the
application under test functions as expected. Tests in a Default test set are controlled from the
user’s machine and require the supervision of the tester.

l Performance test sets include performance tests which check that the application under test
can withstand load and demand. Tests in a Performance test set are scheduled in a timeslot to
run on a server, without requiring user supervision. Available for: ALM Edition and Performance
Center Edition only.

Note: For the purposes of this tutorial, we will only use Functional and Default test sets. The
usage of Performance tests is covered inHP ALM Performance Center Quick Start.

To decide which types of test sets to create, consider the goals you defined at the beginning of the
application lifecycle management process.

When creating and combining different groups of test sets, consider issues such as the current
state of the application and the addition or modification of new features. Following are examples of
general categories of test sets you can create:
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Test Set Description

Sanity Checks entire application at a basic level—focusing on breadth, rather than
depth—to verify that the application is functional and stable. This set includes
fundamental tests that contain positive checks, validating that the application is
functioning properly. For example, in theMercury Tours application, you could test
whether the application opens and enables you to log in.

Regression Tests the system in amore in-depthmanner than a sanity set. This set can include
both positive and negative checks. Negative tests attempt to fail an application to
demonstrate that the application is not functioning properly.

Advanced Tests both breadth and depth. This set covers the entire application, and also tests
the application’s advanced options. You can run this set when there is ample time
for testing.

Function Tests a subsystem of an application. This could be a single feature or a group of
features. For example, in theMercury Tours application, a function set could test
all activities related to booking a flight.

Defining Test Sets
In this exercise, you will define theMercury Tours Site test set. You will also set failure rules for the
test set to instruct ALM how to proceed in the event that an automated test in the test set fails.
Depending on whether you are an ALM Edition user, you can either define a Functional test set or a
Default test set.

Note:

l If you are using ALM Edition, define a Functional test set. See "Defining a Functional Test
Set" below.

l If you are not using ALM Edition, define a Default test set. See "Defining a Default Test
Set" on page 70.

Defining a Functional Test Set
Functional test sets contain automatic tests. Tests in a Functional test set run using automated
server-side execution.

To define a Functional test set:

1. Display the Test Labmodule.

On the ALM sidebar, under Testing, select Test Lab.

2. Add a folder to the test sets tree.

a. In the test sets tree in the left pane, select theRoot folder.

b. Click theNew Folder button. The New Test Set Folder dialog box opens.

c. In the Folder Name box, type Service Pack 1 and click OK.
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3. Create subfolders for the test set folder.

Select theService Pack 1 folder and repeat the previous step to create two subfolders, named
Cycle 1 - New Features, and Cycle 2 - Full.

4. Assign the test set folders to a cycle.

a. Right-click theCycle 1 - New Features test set folder and select theAssign to Cycle
button. The Select Cycles dialog box opens.

b. Expand theService Packs releases folder. In theService Pack 1 release, select the
Cycle 1 - New Features cycle (created in Lesson 2, "Specifying Releases and Cycles" on
page 28).

c. Click OK. The icon for the folder in the test sets tree changes to show that the folder has
been assigned to a cycle.

d. Right-click theCycle 2 - Full test sets folder and chooseAssign to Cycle. Assign the
folder to theCycle 2 - Full cycle, located in theService Pack 1 release in the releases
tree.

5. Add a test set to the Cycle 1 - New Features test set folder.

a. In the test sets tree, select Cycle 1- New Features.

b. Click theNew Test Set button. The New Test Set dialog box opens.
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c. Enter the following:

Name: Mercury Tours Site

Description: This test set includes automatic tests that run on remote testing hosts and
verify the functionality of theMercury Tours site.

d. Select Functional in the Type field.

e. Click OK. TheMercury Tours Site test set is added to the test sets tree in the left pane.

6. Define theMercury Tours Site test set details.

a. Click the test set in the test sets tree. TheExecution Grid tab is displayed. Click on the
Details tab.
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b. Select the following:

Open Date: Select a date from the calendar for the planned opening date for the test set.
Today's date is selected by default.

Close Date: Select the planned closing date for the test set.

7. Set rules for the automated tests in the test set in the event of a test failure.
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a. Click theAutomation tab.

b. In theOn Automatic Test Failure section, perform the following:

o Select theRerun test check box.

o SetMaximum test reruns to 1.

8. Instruct ALM to send an email to specific users if certain events occur.

UnderNotification, perform the following:

a. Select the check box to send an email notification if any test in the test set fails.

b. To: Enter your email address.

c. Message: Type the following:

This test failed. Please review the test results and submit a defect.

Defining a Default Test Set
Default test sets contain automatic andmanual tests. You start and control tests in a Default test
set using your local machine.

Note: In this exercise, you define a Default test set. If you are using ALM Edition, you already

HP ALM (11.52)Page 70 of 184

Tutorial
Chapter 5: Running Tests



defined a Functional test set. You can proceed to "Adding Tests to a Test Set" on page 75.

To define a Default test set:

1. Display the Test Labmodule.

On the ALM sidebar, under Testing, select Test Lab.

2. Add a folder to the test sets tree.

a. In the test sets tree in the left pane, select theRoot folder.

b. Click theNew Folder button. The New Test Set Folder dialog box opens.

c. In the Folder Name box, type Service Pack 1 and click OK.

3. Create subfolders for the test set folder.

Select theService Pack 1 folder and repeat the previous step to create two subfolders, named
Cycle 1 - New Features, and Cycle 2 - Full.

4. Assign the test set folders to a cycle.

Note: If you are using HP ALM Essentials Edition, fields and commands related to cycles
and releases are not available. Proceed to the next step.

a. Right-click theCycle 1 - New Features test set folder and select theAssign to Cycle
button. The Select Cycles dialog box opens.

b. Expand theService Packs releases folder. In theService Pack 1 release, select the
Cycle 1 - New Features cycle (created in Lesson 2, "Specifying Releases and Cycles" on
page 28).

c. Click OK. The icon for the folder in the test sets tree changes to show that the folder has
been assigned to a cycle.

d. Right-click theCycle 2 - Full test sets folder and chooseAssign to Cycle. Assign the
folder to theCycle 2 - Full cycle, located in theService Pack 1 release in the releases
tree.

5. Add a test set to the Cycle 1 - New Features test set folder.

a. In the test sets tree, select Cycle 1- New Features.

b. Click theNew Test Set button. The New Test Set dialog box opens.
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c. Enter the following:

Name: Mercury Tours Site

Description: This test set includes automatic andmanual tests that verify the functionality
of theMercury Tours site.

d. Select Default in the Type field.

e. Click OK. TheMercury Tours Site test set is added to the test sets tree in the left pane.

6. Define theMercury Tours Site test set details.

a. Click the test set in the test sets tree. TheExecution Grid tab is displayed. Click on the
Details tab.
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b. Select the following:

Open Date: Select a date from the calendar for the planned opening date for the test set.
Today's date is selected by default.

Close Date: Select the planned closing date for the test set.

7. Set rules for the automated tests in the test set in the event of a test failure.
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a. Click theAutomation tab.

b. Perform the following:

o On Automatic Test Failure: Select theRerun test check box. InMaximum test
reruns, set to 1.

o On final failure: Make sure that theDo nothing option is selected.

8. Instruct ALM to send an email to specific users if certain events occur.

UnderNotification, perform the following:

a. Send email in the event of: Select the first check box to send email notification if any
test in the test set fails.

b. To: Enter your email address.

c. Message: Type the following:

This test failed. Please review the test results and submit a defect.
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Adding Tests to a Test Set
After you define a test set, select tests for inclusion in the test set. ALM adds instances of the
selected tests to the test set. Each instance contains a defined test configuration. In this exercise,
you will add tests to theMercury Tours Site test set.

Note:

l If you are using ALM Edition, add a test to your Functional test set. See "Adding Tests to a
Functional Test Set" below.

l If you are not using ALM Edition, add a test to your Default test set. See "Adding Tests to a
Default Test Set" on next page.

Adding Tests to a Functional Test Set
In this exercise, you add an automatic test to theMercury Tours Site test set.

To add automatic tests to a Functional test set:

1. Display theExecution Grid tab.

a. If the Test Labmodule is not displayed, on the ALM sidebar, under Testing, select Test
Lab.

b. Click theExecution Grid tab if it is not yet displayed.

2. Select theMercury Tours Site test set.

In the test sets tree, expand theCycle 1 - New Features test set folder underService Pack 1.
Select theMercury Tours Site test set.

3. Display the right pane if it is not already displayed.

Click theSelect Tests button. The right pane displays the Test Plan Tree and Requirements
Tree tabs.
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The Test Plan Tree tab enables you to select tests from the test plan tree to add to the test
set. TheRequirements Tree tab enables you to select tests covering requirements to add to
the test set.

4. Add theNumber of Passengers test to the test set.

a. Under the Flight Reservation folder, expand the Flight Finder folder.

b. Drag theNumber of Passengers test from the test plan tree to the Execution Grid to add it
to the test set.

5. Close the right pane.

Click theClose button.

Adding Tests to a Default Test Set

Note: In this exercise, you add tests to a Default test set. If you are using ALM Edition, you
already added tests to a Functional test set. Proceed to "Defining a Build Verification Suite" on
page 79.

To add manual tests to a Default test set:

1. Display theExecution Grid tab.

a. If the Test Labmodule is not displayed, on the ALM sidebar, under Testing, select Test
Lab.

b. Click theExecution Grid tab if it is not yet displayed.

2. Select theMercury Tours Site test set.
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In the test sets tree, expand theCycle 1 - New Features test set folder underService Pack 1.
Select theMercury Tours Site test set.

3. Display the right pane if it is not already displayed.

Click theSelect Tests button. The right pane displays the Test Plan Tree and Requirements
Tree tabs.

The Test Plan Tree tab enables you to select tests from the test plan tree to add to the test
set. TheRequirements Tree tab enables you to select tests covering requirements to add to
the test set.

4. Add theCredit Card test to the test set.

a. In the Test Plan Tree tab, expand thePayment Methods folder and select theCredit
Cards test.

b. If the Test Configurations pane is not displayed, click theShow button on the bottom of the
pane. Under the Test Configurations pane, you can see the three test configurations for the
selected test.
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c. To include all test configurations, in the Test Plan Tree tab, click theAdd Tests to Test
Set button. The instances are added to the test set.

5. Add several tests from the Book Flight folder to the test set.

a. Under the Flight Reservation folder, expand theBook Flight folder.

b. Select thePassenger Name test.

c. Press the CTRL key and select the following tests: Credit Card Number, Credit Card
Expiration Date, Credit Card Owner, andBilling And Delivery Address. Click the
Add Tests to Test Set button. The Parameter Values dialog box opens.

d. Click Close. The instances are added to the test set.

6. Add the Number of Passengers test to the test set.

a. Under the Flight Reservation folder, expand the Flight Finder folder.

b. Drag theNumber of Passengers test from the test plan tree to the Execution Grid to add it
to the test set.

7. Close the right pane.

Click theClose button.
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Defining a Build Verification Suite
Note: The Build Verificationmodule is available only for users with ALM Edition. If you are not
using ALM Edition, proceed to "Setting Schedules and Conditions for Test Runs" on page 81.

The Build Verificationmodule enables you to define a group of Functional test sets bundled together
with a single Performance test. This group of test sets is called a build verification suite. When run
together, the build verification suite checks the overall status of your build.

You can create a small suite to run immediately after a build in themiddle of the day, create a suite
with a few Functional test sets to run once every hour, or create a large suite to run for several hours
every night.

Build verification suites are a key component in HP's Continuous Delivery solution. They facilitate
an automated, end-to-end deployment and testing framework that makes application development
more efficient, reliable, and quick.

In this exercise, you will create a build verification suite that includes Functional test sets.

To define a build verification suite:

1. Display theBuild Verificationmodule.

On the ALM sidebar, under Testing, select Build Verification.

2. Add a folder to the Build Verification Suites tree.

a. In the Build Verification Suites tree in the left pane, select the root Build Verification
Suites folder.
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b. Click theNew Folder button. The New Build Verification Suite Folder dialog box opens.

c. In the Folder Name box, typeMercury Tours Build Verification and click OK.

3. Add a build verification suite to theMercury Tours Build Verification set folder.

a. In the build verification suites tree, selectMercury Tours Build Verification.

b. Click theNew Build Verification Suite button. The New Build Verification Suite dialog
box opens.

c. Type the following:

Name: Mercury Tours Verification - Hourly

Description: This build verification suite includes test sets that run on an hourly basis to
verify the stability of theMercury Tours site functionality.

d. Click OK. TheMercury Tours Verification - Hourly build verification suite is added to the
test sets tree in the left pane.

4. Open the Functional Test Sets tab.

In the build verification suites tree, selectMercury Tours Verification - Hourly. Select
Functional Test Sets from the tabs in the right pane.

5. Add a Functional test set to the build verification suite.

Click theSelect Test Sets button. The right pane displays the Test Sets Tree tab. The Test
Sets Tree tab enables you to select test sets from the test set tree to add to the build
verification suite.

Add theMercury Tours Site test set to the build verification suite.

a. Under theService Pack 1 folder, expand theCycle 1 - New Features folder.

b. Drag theMercury Tours Site test set from the test sets tree to the Functional Test Sets
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tab to add it to the build verification suite.

You can now schedule a timeslot to run this build verification suite.

Setting Schedules and Conditions for Test
Runs

The Execution Flow tab enables you to specify a date and time to execute a test instance and set
conditions for it. A condition is based on the results of another specified test instance in the
Execution Flow. By setting conditions, you can postpone the execution of a test instance until
another specified test instance finishes running or passes. You can also set the sequence in which
to execute the test instances.

For example, you can determine that Test 2 will run only if Test 1 passed, and Test 3 will run only if
Test 2 passed. Test 1 is scheduled to run at 9:00 AM on a specified date. The Execution Flow
displays the tests and their conditions in a diagram.

A blue line arrow indicates that the test instance is to be executed after the previous
test instance, with no conditions. A green line arrow indicates that the test instance
is to be executed only if the previous test instance has status Passed. A black line
arrow indicates that the test instance is to be executed only if the previous test instance has
finished running. When a test instance is time-dependent, a TimeDependency icon is added to
the diagram.
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In this exercise, you will create a new Default test set and add to it three test instances that verify
the login procedure on the Sign-On page of theMercury Tours site. Then, you will set the conditions
for each instance and specify when each one is to be run.

To schedule a test run in the Execution Flow tab:

1. Make sure the Test Labmodule is displayed.

On the ALM sidebar, under Testing, select Test Lab.

2. Create a new test set.

a. In the test sets tree, choose theService Pack 1 folder and click theNew Test Set button.
The New Test Set dialog box opens.

b. Type the following:

Name: Test Run Schedule

Description: This test set is used to explain how to schedule a test run.

c. Click OK. The Test Run Schedule test set is added to the test sets tree in the left pane.

3. Add tests from the Sign-On/Sign-Off folder to the Test Run Schedule test set.

a. Click theExecution Flow tab. If the right pane is not already displayed, click theSelect
Tests button. The Test Plan Tree tab and the Requirements Tree tab are displayed.

b. In the Test Plan Tree tab, under theProfiling folder, expand theSign-On/Sign-Off folder.

c. Press the CTRL key and select the following tests: Sign-On Page, Sign-On User Name,
andSign-On Password. Click theAdd Tests to Test Set button. The Parameter Values
dialog box opens.
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d. Click Close. The test instances are added to the test set.

4. Add an execution condition to the Sign-OnUser Name test.

a. In the Execution Flow tab diagram, right-click theSign-On User Name test instance and
choose Test Run Schedule. The Run Schedule dialog box opens and displays the
Execution Conditions tab.
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b. Click New Execution Condition. The New Execution Condition dialog box opens.

c. In the Test dropdown list, select [1]Sign-On Page.

d. Select Passed from the list on the right to instruct ALM to execute theSign-On User
Name test instance only if theSign-On Page test instance finishes executing and passes.

e. Click OK. The condition is added to the Run Schedule dialog box.
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5. Add a time dependency condition to the Sign-OnUser Name test instance.

a. Click the Time Dependency tab.

b. Click Run At Specified Time. Select theDate check box and select tomorrow’s date.

c. Click OK to close the Run Schedule dialog box. Your conditions are displayed in the
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Execution Flow diagram.

6. Add an execution condition to the Sign-On Password test.

Add the same execution condition as described in Step 4 for theSign-On Password test. This
time select Sign-On User Name from the Test box in the New Execution Condition dialog
box.

7. Add a time dependency condition to the Sign-On Password test.

a. Add the same time dependency condition as described in Step 5 for theSign-On
Password test.

b. Click OK to close the Run Schedule dialog box. Your conditions are displayed in the
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Execution flow diagram.

Running Tests
In this exercise, you will define theMercury Tours Site test set. You will also set failure rules for the
test set to instruct ALM how to proceed in the event that an automated test in the test set fails.
Depending on whether you are an ALM Edition user, you can either define a Functional test set or a
Default test set.

Note:

l If you are using ALM Edition, run a test in your Functional test set. See "Running Tests in a
Functional Test Set" below

l If you are not using ALM Edition, run a test in your Default test set. See "Running Tests in a
Default Test Set Manually" on page 91 and "Running Tests in a Default Test Set
Automatically" on page 100.

Running Tests in a Functional Test Set
When you run tests from a Functional test set, ALM uses LabManagement to execute the tests on
remote testing hosts equipped with the testing tools. LabManagement updates ALM with the
results of your tests. You can run all tests in a Functional test set or run specific tests. You can use
the Execution Grid tab to run a test set immediately. You can also use the Timeslots module to
reserve resources for a test to run in the future.
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You can run build verification suites in the sameway as test sets. You use the Build Verification
module to run a build verification suite immediately, and you use the Timeslots module to reserve
resources for a build verification suite to run in the future.

In these exercises, you will learn about the following:

l "Running a Functional Test Set in the Test Labmodule" below

l "Scheduling a Functional Test Set in the Timeslots Module" on page 90

Running a Functional Test Set in the Test Lab
module

You can run tests from a Functional test set immediately using the Execution Grid.

In this exercise, you will run theMercury Tours Site test set in the Test Labmodule.

To run a Functional test set in the Test Lab module:

1. Make sure the Test Labmodule is displayed.

On the ALM sidebar, under Testing, select Test Lab.

2. Select theMercury Tours Site test set.

In the test set tree, expand theCycle 1 - New Features test set folder underService Pack 1.
Select theMercury Tours Site test set.

3. Open the Run Functional Test Set dialog box.

Click theRun Test Set button. The Run Functional Test Set dialog box opens.
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4. Run the test set.

Click theRun button. ALM uses LabManagement to execute your test on a testing host with
the required testing tool.

5. View the progress of the run.

ALM opens the Execution Report page, which displays the current state and results of the
tests you executed. You can refresh the page, stop tests, and view an Event Log for the entire
run.
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6. Close the Execution Report.

After the test run is complete, close the Execution Report page.

Scheduling a Functional Test Set in the Timeslots
Module

You can reserve resources for the execution of a Functional test set using the Timeslots module.

In this exercise, you schedule theMercury Tours Site test set in the Timeslots module.

To schedule a Functional test set in the Timeslots module:

1. Make sure the Timeslots module is displayed.

On the ALM sidebar, under Testing, select Timeslots.

2. Create a new Timeslot.

On the Timeslots toolbar, click theNew Timeslot button. The Timeslot Reservation dialog box
opens.

3. Schedule your Functional test set.

a. In theRun field, select Functional Test Set.

b. In theStart field, select Automatically.

c. In theName field, typeMercury Tours Nightly.

d. Click the [none] link inSelect a test set, and select theMercury Tours Site test set.
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e. Use theStart Time andEnd Time fields to schedule the test set to run from 20:00 to
22:00.

f. A host is automatically added to theRequested Hosts grid.

g. Click theCalculate Availability button to check that the timeslot is valid.

4. Submit the timeslot.

Click Submit.

Running Tests in a Default Test Set Manually
When you run a test manually, you follow the test steps and perform operations on your application.
Then, you compare the expected results with the actual outcome and record the results. You can
execute amanual test as many times as needed. The results are stored separately for each run.

Note: In these exercises, you run Default test sets. If you are using ALM Edition, you already
ran a Functional test set. To continue in the tutorial, proceed to "Viewing and Analyzing Test
Results" on page 101.

You can run bothmanual and automated tests manually as part of a Default test set. You can also
choose to run a single test or to run an entire test set.

You runmanual tests in ALM using HP Sprinter, HP’s solution for manual testing. If you are not
working with Sprinter, you run tests manually usingManual Runner.
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In these exercises, you will learn about the following:

l "Running with Sprinter" below

l "Running with Manual Runner" on page 96

Running with Sprinter
Sprinter provides advanced functionality and tools to assist you in themanual testing process.
Sprinter is fully integrated with ALM, enabling you to get themaximum benefit from both solutions.

Note:

l Sprinter functionality is not available with Quality Center Starter Edition or Performance
Center Edition.

l For information on installing Sprinter, see "Before You Begin" on page 9.

In this exercise, you will run theCredit Cards test. This test contains three test configurations. For
the purpose of this exercise, you will perform the steps without testing them against theMercury
Tours application.

To run a test using Sprinter:

1. Open Sprinter.

a. If the Test Labmodule is not displayed, on the ALM sidebar, under Testing, select Test
Lab.

b. Click theExecution Grid tab.
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c. Click theRun arrow and select Run with Sprinter. HP Sprinter opens.

2. Select the instances to run from the test set.

a. Click theOpen HP ALM Tests button. TheOpen dialog box opens.

b. In the left pane, expand theRoot folder. UnderService Pack 1, expandCycle 1 - New
Features. Select theMercury Tours Site test set. The test set is displayed.
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c. Select American Express, Visa, andMasterCard check boxes. Click Open.

3. Display the test steps to run the American Express instance.

Click theRun the Active Test button. The Steps pane is displayed.

4. Perform the first step.

a. Click theActual Result button. In the Actual Result dialog box, type: TheMercury Tours
site opens. Click OK.

b. Click thePassed Selected Step button.

5. Perform the second step.

a. Click theActual Result button. In the Actual Result dialog box, type: Flight details and
preference are entered. Click OK.

b. Click thePassed Selected Step button.
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6. Pass the remaining steps.

Click thePassed Selected Step arrow and select Pass All.

7. Continue on to the Visa instance.

Click Next Test. Sprinter advances to the next instance in the test list.

8. Pass all steps of the Visa instance.

Click thePassed Selected Step arrow and select Pass All.

9. Continue on to theMasterCard instance.

Click Next Test. Sprinter advances to the next instance in the test list.

10. Pass all steps of theMasterCard instance.

Click thePassed Selected Step arrow and select Pass All.

11. Fail the last step on theMasterCard instance.

Select Step 8 and click the Fail Selected Step button.

12. End the run and view run results.

a. In the upper-right side of your screen, click Run Control. The Run Control pane opens.

b. Click theEnd Run button.

c. Under Tests, you view the run results.

13. View results in the Execution Grid tab.

CloseSprinter.
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The test run results are displayed in the execution grid. The Last Run Report pane displays run
results of each test step.

Running with Manual Runner
If Sprinter is not installed you can run tests manually usingManual Runner.

In this exercise, you will run theCredit Cards test. This test contains three test configurations. For
the purpose of this exercise, you will perform the steps without testing them against theMercury
Tours application.

To run a test using Manual Runner:

1. Make sure theCycle 1 - New Features test set folder is displayed in the Execution Grid.

a. If the Test Labmodule is not displayed, on the ALM sidebar, under Testing, select Test
Lab.

b. In the test set tree, expand theCycle 1 - New Features test set folder underService Pack
1. Select theMercury Tours Site test set.

c. Click theExecution Grid tab.

2. Select the instances to run from the test set.

Press the CTRL key and select the following instances in the Execution Grid: American
Express, Visa, andMasterCard.

3. OpenManual Runner.

Click theRun arrow and select Run with Manual Runner. TheManual Runner dialog box
opens.
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4. Start the test run.

Click theBegin Run button. TheManual Runner dialog box opens.
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5. Perform the first step.

a. In theActual box, type: TheMercury Tours site opens.

b. Click thePass Selected button. Step 2 is displayed.

6. Perform the second step.

a. In theActual box, type: Flight details and preference are entered.

b. Click thePass Selected button. Step 3 is displayed.

7. Pass the remaining steps.

Click thePassed Selected arrow and select Pass All.

8. End the run.

Click theEnd Run button to end your test run.

9. Continue on to the Visa instance.
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Click theBegin Run button. TheManual Runner dialog box opens. Note the name of the
instance in the title bar.

10. Pass all steps of the Visa instance.

Click thePassed Selected arrow and select Pass All.

11. End the run.

Click theEnd Run button to end your test run.

12. Continue on to theMasterCard instance.

Click theBegin Run button. TheManual Runner dialog box opens. Note the name of the
instance in the title bar.

13. Fail all steps of theMasterCard instance.

Click the Fail Selected arrow and select Fail All.

14. End the run.

Click theEnd Run button to end your test run.

15. View the run results in the Execution Grid.

Following the execution of your tests, you can view the run results of your last run in the
Execution Grid.

16. View the results of each test step in the Last Run Report pane.

a. Select one of the recently run instances. If the Last Run Report pane is not displayed, click
theShow button on the bottom of the pane. The Last Run Report pane is displayed below
the Execution Grid.

b. Click each step to view its description, as well as the expected and actual results.
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Running Tests in a Default Test Set Automatically
When you run an automated test from aDefault test set, ALM automatically opens the selected
testing tool, which runs the test on your local machine or on remote hosts, and imports the results to
ALM.

You can run all tests in a test set or run specific tests. You can run tests from the Execution Grid
tab or the Execution Flow tab.

In this exercise, you will run aQuickTest Professional test.

Note: For prerequisites to running aQuickTest Professional test, see "Before You Begin" on
page 9.

To run a test automatically:

1. Make sure the Test Labmodule is displayed.

On the ALM sidebar, under Testing, select Test Lab.

2. Select theNumber of Passengers test.

a. In the test sets tree, expand theMercury Tours Web Site test set folder. Under
Functionality And UI, select theMercury Tours Functionality test set.

b. Click theExecution Grid tab.

c. Select theNumber of Passengers test.

3. Open the Automatic Runner dialog box.

Click theRun button. The Automatic Runner dialog box opens and displays the selected test.
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4. Set the test run settings.

Select theRun All Tests Locally check box to run the test on your local computer.

5. Run the test.

Click theRun button. ALM opens the selected testing tool automatically and runs the test. You
view the test execution progress in theStatus column.

6. Close the Automatic Runner dialog box.

After the test run is complete, chooseRun > Exit.

7. View a summary of test results in the Execution Grid.

The Execution Grid displays the updated status for the test run. Results for each test step
appear in the Last Run Report pane.

8. Close QuickTest Professional.

In QuickTest Professional, choose File > Exit.

Viewing and Analyzing Test Results
ALM provides a number of features that enable you to view and analyze the results of your tests.

This section includes:

l "Viewing Test Results in the Test Runs Module" below

l "Viewing Test Results in the Test Instance Properties Dialog Box" on page 103

l "Viewing Test Coverage" on page 105

l "Viewing Coverage Progress" on page 107

You can also use ALM reports and graphs to further analyze your test results. For more information,
see "Analyzing ALM Data" on page 130.

Viewing Test Results in the Test Runs Module
You can view results for a test in the Test Runs module. You can use the grid to compare the
results of recent test runs with previous test runs.

In the below exercise, you will learn how to view test run information in the Test Runs module.

Viewing Functional Test Set Results in the Test
Set Runs Tab

If you are using ALM Edition, you can view the results of your Functional test set runs in the Test
Set Runs tab.

To view test set results in the Test Set Runs tab:

1. Make sure the Test Runs module is displayed.

On the ALM sidebar, under Testing, select Test Runs.
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2. View detailed test results from the Test Set Run Details dialog box.

Click the Test Set Runs tab. Select theMercury Tours Site test set run in the grid and click
the Test Set Run Details button. The Test Set Run Details dialog box opens, containing
details about the test set run.

3. Close the Test Set Run Details dialog box.

Click theClose button.

4. View test run information in the Execution Report page.

Select theMercury Tours Site test run and click theShow Report button. TheExecution
Report page opens. The Execution Report page displays information about the overall test set
run and detailed information about each test instance run.

Viewing Test Results in the Test Runs Tab
In this exercise, you view the results of individual test instance runs.

To view test results in the Test Runs tab:

1. Make sure the Test Runs module is displayed.

On the ALM sidebar, under Testing, select Test Runs.
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2. View detailed test results from the Test Run Details dialog box.

Make sure the Test Runs tab is displayed. Select theAmerican Express test run and click
the Test Run Details button. The Test Run Details dialog box opens.

3. View other test run information in the Test Run Details dialog box.

a. Click Report to display results and test step details of the run.

b. Click Linked Defects to list the defects linked to the run.

c. Click History to list the changes made to the run.

4. Close the Test Set Run Details dialog box.

Click theClose button.

Viewing Test Results in the Test Instance
Properties Dialog Box

You can view results for a test in the Test Instance Properties dialog box. This includes details of a
test’s runs, attachments, linked defects, and history.

To view test results in the Test Instance Properties dialog box:

1. Make sure the Test Labmodule is displayed.

On the ALM sidebar, under Testing, select Test Lab.
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2. Make sure theCycle 1 - New Features test set folder is displayed.

a. In the test set tree, expand theCycle 1 - New Features test set folder underService Pack
1. Select theMercury Tours Site test set.

b. Click theExecution Grid tab.

3. Select American Express in the Execution Grid.

In the Execution Grid tab, select American Express.

4. View detailed test results from the Test Instance Details dialog box.

Click the Test Instance Details button. The Test Instance Details dialog box opens.

5. View test run information.

Click Runs. The run details are displayed.

6. View other test run information in the Test Instance Details dialog box.

a. Click Execution Settings to view parameters used to run the instance. Note that any
changes that youmake are implemented in the next test run.

b. Click Linked Defects. This view lists the defects linked to the currently selected test
instance. You can view, add, and remove defect links.

c. Click History to view a list of changes made to the test run fields.

7. Close the Test Instance Details dialog box.

Click theClose button.
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Viewing Test Coverage
You previously saw how you can use the Coverage Analysis view to analyze the breakdown of
child requirements according to their tests coverage (see "Analyzing Coverage" on page 57).

In this exercise, you will learn how to filter the tests included in the coverage analysis by cycle.

Note: This exercise is not available for HP ALM Essentials Edition.

To view test coverage:

1. Display the Coverage Analysis view in the Requirements module.

a. On the ALM sidebar, underRequirements, select Requirements.

b. ChooseView > Coverage Analysis. The Coverage Analysis view is displayed.

2. Filter the coverage analysis by cycle.

a. On the upper-right side of the window, click theSettings button. The Analysis Settings
dialog box opens.

b. Select Execution Analysis. Click the arrow. In the releases tree, expand the release
folderService Packs and the releaseService Pack 1. Select theCycle 1 - New Features
check box and click OK.

c. Click OK to close the Analysis Settings dialog box.

d. Expand thePayments requirement. In the Coverage Analysis column, you can see that
the requirement has failed. This is because the Credit Cards test that covers the
requirement failed.

3. Display test coverage details for the Credit Cards requirement.
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a. Right-click theCredit Cards requirement, and chooseCoverage Analysis. The Coverage
Analysis dialog box opens.

b. Click theShow Test Coverage link to extend the Coverage Analysis dialog box and
display the Test Coverage Chart.

c. This pie chart graphically displays the full test coverage for the requirement, grouped
according to test status.

d. Click the pie chart to open the Test Coverage dialog box.
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The dialog box shows the failed test together with the test run status of each test
configuration.

e. Close the Test Coverage dialog box.

4. Close the Coverage Analysis dialog box.

Click theClose button.

Viewing Coverage Progress
Youwere previously introduced to the Progress tab in the Releases module (see "Viewing
Releases and Cycles" on page 30).

In this exercise, you will view the graphs and statistics that now reflect the results of tests you ran
in previous exercises.

Note: This exercise is not available for HP ALM Essentials Edition.

To view coverage progress:

1. Display the Releases module.

On the ALM sidebar, underManagement, select Releases.

2. View the effect of your test runs on the Progress tab.
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In the releases tree, expand the release folderService Packs and the releaseService Pack 1.
Select Cycle 1 - New Features and click theProgress tab.

The top pane shows information such as the total and remaining days in the cycle, total test
instances for the cycle, and actual and remaining test instances to run.

The bottom pane displays the Coverage Progress graph. Planned coverage indicates the
percentage of tests planned to be run each day within a cycle. Executed coverage indicates
the percentage of tests that ran each day within a cycle. Passed coverage indicates the
percentage of tests that ran successfully each day within a cycle.
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Chapter 6: Adding and Tracking Defects
Locating and repairing defects is an essential phase in application development. Defects can be
detected and submitted by users in all stages of the application lifecycle management process.
Using HP Application Lifecycle Management (ALM), you can submit defects detected in the
application and track them until they have been repaired and retested.

In this lesson, you will learn about:

How to Track Defects 111

Adding New Defects 111

Matching Defects 113

Updating Defects 114

Linking Defects to Tests 117

Creating Favorite Views 119
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How to Track Defects
When you submit a defect to an ALM project, it is tracked through these stages: New, Open, Fixed,
and Closed. A defect may also be Rejected or it may be Reopened after it is fixed.

When you initially report the defect to an ALM project, it is assigned the status New, by default. A
quality assurance or project manager reviews the defect and determines whether or not to consider
the defect for repair. If the defect is denied, it is assigned the status Rejected. If the defect is
accepted, the quality assurance or project manager determines a repair priority, changes its status
toOpen, and assigns it to amember of the development team. A developer repairs the defect and
assigns it the status Fixed. You then retest the application, making sure that the defect does not
recur.

If the defect recurs, the quality assurance or project manager assigns it the status Reopened. If the
defect is repaired, the quality assurance or project manager assigns it the status Closed.

Adding New Defects
You can add a new defect to an ALM project at any stage of the application lifecycle management
process. In this exercise, you will submit a defect connected to the Flight Confirmation test.

To add a defect:

1. Open the ALM_Demo project.

If theALM_Demo project is not already open, log in to the project. For more information, see
"Starting ALM" on page 17.
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2. Display the Defects module.

On the ALM sidebar, select Defects. The Defects Grid displays defect data in a grid. Each row
in the grid displays a separate defect record.

3. Open the New Defect dialog box.

Click theNew Defect button. The New Defect dialog box opens.

4. Describe the defect.

Enter the following data in the specified fields. Scroll down the dialog box as necessary.

Summary: Missing information on Flight Confirmation page.

Category: Defect

Severity: 2-Medium

Subject: Flight Reservation > Flight Confirmation

Description: The defect was detected on the Flight Confirmation page. Passenger details and
meal preferences are not displayed

5. Determine the cycle in which the defect was detected.

Note: If you are using HP ALM Essentials Edition, proceed to Step 6.

a. In theDetected in Cycle box, click the arrow. The releases tree opens. Expand the tree. In
theMercury Tours Application releases folder, in theRelease 10.5 release, select the
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Cycle 1 - New Features cycle.

b. Click OK to close the releases tree.

You can see that ALM automatically assigns the valueRelease 10.5 to theDetected in
Release field. This is becauseCycle 1 - New Features is part of theRelease 10.5
release.

6. Attach the URL address for theMercury Tours page where the defect was detected.

a. On the New Defect dialog box sidebar, click Attachments. The Attachment page opens.

b. Click theURL button. The Attach Uniform Resource Locator (URL) dialog box opens.

c. Type the URL address of theMercury Tours page:

http://<ALM Platform server name>/mtours

d. Click OK. A link to theMercury Tours page is displayed above theDescription box.

7. Add the defect to the ALM project.

a. Click theSubmit button. The defect is added to the Defects Grid.

b. Click Close to close the New Defect dialog box.

Matching Defects
Identifyingmatching defects enables you to eliminate duplicate or similar defects in your project.
Each time you add a new defect, ALM stores lists of keywords from theSummary and
Description fields. When you search for similar defects, keywords in these fields arematched
against other defects. Note that keywords must bemore than two characters long, and letter case
does not affect your results.

In this exercise, you will match defects by comparing a selected defect with all other existing
defects in theALM_Demo project.

To match defects:

1. Make sure that the Defects module is displayed.

If the Defects module is not displayed, on the ALM sidebar, select Defects.

2. Select the Defect.

a. If a filter is applied to the grid, click theSet Filter/Sort arrow and chooseClear Filter/Sort
to clear the filter.

b. In the Defects Grid, select the defect you added in "Adding New Defects" on page 111.

3. Find similar defects.

Click the Find Similar Defects button. The results are displayed in the Similar Defects pane
at the bottom of the window, sorted by the percentage of detected similarity. Note that there
are no duplicate defects in the project for the selected defect.

HP ALM (11.52)Page 113 of 184

Tutorial
Chapter 6: Adding and Tracking Defects



Close the Similar Defects pane.

Updating Defects
Tracking the repair of defects in a project requires that you periodically update defects. You can do
so directly in the Defects Grid or in the Defect Details dialog box. The ability to update some defect
fields depends on your permission settings. After you have updated defects, you can view the
quality status of your release in the Releases module.

In this exercise, you will update your defect information by changing the severity of a defect,
assigning the defect to a cycle, and adding a comment. You will then see how updating defects is
reflected in the Quality tab of the Releases module.

In addition, you will practice updatingmultiple records simultaneously.

Note: If you are using HP ALM Essentials Edition, fields and commands related to cycles and
releases are not available.

To update defects:

1. Make sure that the Defects module is displayed.

If the Defects module is not displayed, on the ALM sidebar, select Defects.

2. Open the Defect Details dialog box.

In the Defects Grid, select the defect you added in "Adding New Defects" on page 111. Click
theDefect Details button. The Defect Details dialog box opens.
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3. Change the severity level of the defect.

In the Severity box, select 5-Urgent.

Note: If you are using HP ALM Essentials Edition, proceed to Step 5.

4. Determine the cycle in which the defect will be fixed.

a. In the Target Cycle box, click the arrow. The releases tree opens. Expand the tree. In the
Mercury Tours Application releases folder, in theRelease 10.5 release, select the
Cycle 4 a - Full cycle.

b. Click OK to close the releases tree.

You can see that ALM automatically assigns the valueRelease 10.5 to the Target
Release field. This is because theCycle 4 a - Full cycle is part of the Release 10.5
release.

5. Add a new comment to explain the change in the severity level.

a. Click theAdd Comment button. A new section is added to theComments box,
displaying your user name and the current date.

b. Type: This defect should be fixed in the next service pack.

6. View the Attachments.

Click Attachments on the sidebar. Note that the URL attachment is listed.

7. View Linked Entities.

Click Linked Entities on the sidebar to view entities that have been linked to the defect.
Linked entities can include requirements, tests, test sets, test instances, runs, run steps, and
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other defects. There are currently no linked entities. You will learn how to link a defect to a test
in "Linking Defects to Tests" on next page.

8. View the History.

Click History on the sidebar to view the history of changes made to the defect. For each
change, the grid displays the date and time of the change and the name of the user whomade
the change. You can expand a change to view a list of fields modified during the change. For
each field, the grid displays the old value and the new value.

9. Close the Defect Details dialog box.

Click OK to exit the dialog box.

10. Update defects directly in the Defects Grid.

Note: If you are using HP ALM Essentials Edition, ignore this step.

a. In the Defects Grid, select defect 35.

b. Click theDetected in Cycle box and click the arrow. In the releases tree, expand the
release folderMercury Tours Application and the releaseRelease 10.5. Select the
Cycle 1 - New Features cycle and click OK.

c. Drag the horizontal scroll bar to the right until the Target Cycle column comes into view.
Click the Target Cycle box for defect ID 23, and click the arrow. In the releases tree,
expand the release folderMercury Tours Application and the releaseRelease 10.5.
Select theCycle 1 - New Features cycle and click OK.

11. Updatemultiple records simultaneously.

a. In the Defects Grid, select defect ID 23.

b. Hold down the CTRL key, and select defect 36. Now both defects 35 and 36 are selected.

c. Select Edit > Update Selected. The Update Selected dialog box opens.

d. Click the arrow adjacent to theUpdate Field box, and select Assigned To. Notice that
theValue box displays theAssigned To value of the defect you selected last.

e. Click the arrow adjacent to theValue box. The users list opens.
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f. In the users list, selectmichael_alm, and click OK.

g. In the Update Selected dialog box, click Update.

h. After the update completes, an Information dialog box displays a summary of the update.
Click OK, then close the Update Selected dialog box.

12. View the number of defects opened inCycle 1 - New Features on theQuality tab.

Note: If you are using HP ALM Essentials Edition, ignore this step.

a. On the ALM sidebar, underManagement, select Releases. On the Releases tree, expand
the release folderMercury Tours Application and the releaseRelease 10.5, and select
the cycleCycle 1 - New Features. Click theQuality tab.

b. In theDefect Opening Rate graph, you can see the defects detected inCycle 1 - New
Features according to defect severity.

c. In theOutstanding Defects graph, you can see the outstanding defects inCycle 1 - New
Features according to defect status.

Linking Defects to Tests
You can link a test in your test plan to a specific defect in the Defects Grid. This is useful, for
example, when a new test is created specifically for a known defect. By creating linkage, you can
determine if the test should be run based on the status of the defect. Note that you can also link the
defect to other entities, such as requirements.

A defect can be linked directly or indirectly to an entity. When you add a defect link to an entity,
ALM adds a direct link to this entity and indirect links to other related entities.

The following diagram illustrates the flow of indirect linkage:
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For instance, when you link a defect to a run step, it adds an indirect link to its run, test instance,
test set, and test. If the same test is covered by a requirement, an indirect link is also added to the
requirement. Note that the indirect linkage is a one-directional flow. For example, if you link a defect
to a run, it is not indirectly linked to its run steps.

In this exercise, you will link your defect to the Flight Confirmation test in the Test Planmodule,
and view the linked test in the Defects Grid.

To link a defect to a test:

1. Display the Test Planmodule.

On the ALM sidebar, under Testing, select Test Plan.

2. Select the Flight Confirmation test.

In the test plan tree, under Flight Reservation, expand the Flight Confirmation test subject,
and select the Flight Confirmation test. Click the Linked Defects tab.

3. Add a linked defect.

a. In the Linked Defects tab, click the Link Existing Defect arrow and chooseSelect. The
Defects to Link dialog box opens.

b. Select the defect you added in "Adding New Defects" on page 111 and click the Link
button. Your defect is added to the Linked Defects grid.

Tip: If you cannot find your defect in the Defects to Link dialog box, click theSet
Filter/Sort arrow and chooseClear Filter/Sort to clear the filter that is applied to the
grid.
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4. View the linked test in the Defects Grid.

a. On the ALM sidebar, select Defects.

b. In the Defects Grid, click the defect ID of the defect you added in "Adding New Defects" on
page 111. The Defect Details dialog box opens.

c. Click Linked Entities on the sidebar, and select theOthers tab. The Flight Confirmation
test is linked to your defect.

d. Click OK to close the Defect Details dialog box.

Creating Favorite Views
A favorite view is a view of an ALM window configured with the settings you applied to it. For
example, in the Defects Grid, youmay want to apply a filter to display only the defects that were
detected by you, are assigned to you, or have the status “Not Closed”.

In this exercise, you will create a favorite view in the Defects Grid.

To create a favorite view:

1. Make sure that the Defects module is displayed.

If the Defects module is not displayed, on the ALM sidebar, select Defects.

2. Define a filter to view defects you detected that are not closed.
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a. Click theSet Filter/Sort button. The Filter defects dialog box opens.

b. For theDetected By field, click the Filter Condition box. Click the arrow. The Select
Filter Condition dialog box opens.
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c. UnderName, select the [CurrentUser] variable, or select your ALM login name from the
list. Click OK to close the Select Filter Condition dialog box.

d. For theStatus field, click the Filter Condition box. Click the arrow. The Select Filter
Condition dialog box opens.

e. In the right pane, click the logical expressionNot.

f. In the left pane, select Closed.

g. Click OK to close the Select Filter Condition dialog box.

h. Click OK to apply your chosen filter. The Defects Grid displays the defects you detected
that are not closed.
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3. Add a favorite view.

a. In the Favoritesmenu, select Add to Favorites. The Add Favorite dialog box opens.

b. In theName box, type: My detected defects (status ‘Not Closed’).

c. You can add a favorite view to either a public folder or a private folder. Views in the public
folder are accessible to all users. Views in the private folder are accessible only to the
person who created them. Select Private.

d. Click OK. The new favorite view is added to your private folder, and is displayed in the list
of recently used favorite views, located under the Private and Public folders.

4. Organize favorites.

a. In the Favoritesmenu, select Organize Favorites. TheOrganize Favorites dialog box
opens.
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b. Double-click thePublic folder.

c. Click theNew Folder button. The New Favorite Folder dialog box opens.

d. In the Favorite Folder Name box, typeQA defects, and click OK. TheQA defects folder
is added as a sub-folder to thePublic folder.

e. Drag the following favorites into theQA defects folder:

o QA Bug Verification

o QA Team Member - My Fixed and Rejected defects

f. Click Yes to confirm, and close the Organize Favorites dialog box.
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Chapter 7: Alerting on Changes
You can instruct HP Application Lifecycle Management (ALM) to create alerts automatically and
send emails to notify those responsible when certain changes occur in your project that may impact
the application lifecycle management process. You can also add your own follow-up alerts.

To generate automatic notification alerts, your ALM project administrator must activate alert rules in
Project Customization. Alert rules are based on associations youmake in ALM between
requirements, tests, and defects. When an entity in your project changes, ALM alerts any
associated entities that may be impacted by the change. The alerts can be seen by all users. ALM
also notifies the person responsible for the entity at the time of the change of any associated
entities that may be impacted by the change.

ALM also enables you to add your own follow-up flag to a specific requirement, test, test instance,
or defect to remind you to follow up on an issue. When the follow-up date arrives, ALM sends you
an email reminder.

In this lesson, you will learn about:

Triggering an Alert 125

Creating Follow Up Alerts 127
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Triggering an Alert
When a requirement, test, test instance, or defect in your project changes, ALM can notify those
responsible for any associated entities. You can associate tests with requirements (see "Creating
and Viewing Coverage" on page 54) and defects with other ALM entities (see "Linking Defects to
Tests" on page 117). In addition, you can create traceability links between requirements. For more
information on creating traceability links between requirements, see theHP Application Lifecycle
Management User Guide.

ALM can generate alerts for these changes:

What changed?
Which associated
entities are flagged?

Who is
notified?

Requirement (excluding change of Direct Cover
Status and risk-based quality management fields)

Tests Test designers
Requirements Requirement

authors

Defect status changed to Fixed Test instances Responsible
testers

Test ran successfully Defects Users
assigned to
defects

In this exercise, you will trigger alerts for tests by changing the associated requirement. You will
modify theView Reservations requirement and then you will view the flagged tests.

To trigger an alert:

1. Display the requirements tree.

a. On the ALM sidebar, underRequirements, select Requirements.

b. In the Requirements module, select View > Requirement Details.

2. Select the requirement that you want to change.

UnderReservation Management, select theView Reservations requirement.

3. View the associated tests.

To view the tests that will be impacted by the change, click the Test Coverage tab. The tab
displays the associated tests.

4. Change the priority of the View Reservations requirement.

a. Click theDetails tab.

b. Click the down arrow adjacent to thePriority box and select 5-Urgent.

Note: Version Control: If you are prompted to check out the requirement, click OK.

This change causes ALM to generate alerts for the tests associated with the requirement.
ALM also sends email notification to the designers of the associated tests.
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Note: Version Control: Check in the new version of the requirement. Right-click the
requirement, and select Versions > Check In. Click OK to confirm.

5. View the alert for the Flight Confirmation test.

a. In the Test Coverage tab, click the link to the Flight Confirmation test. The test is
highlighted in the test plan tree.

b. Click theRefresh All button.

The Flight Confirmation test has an alert flag , indicating that a change was made to an
associated requirement.

c. Click theAlerts flag for the Flight Confirmation test. The Alerts dialog box opens.
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The alert indicates the requirement and the change that triggered the alert. It also indicates
the name of the person to whom ALM sends email notification of this change.

Note: Version Control: The alert states that the version status has changed to
Checked In. It does not indicate which fields have beenmodified. You can then
compare the new version with the previous version.

d. Click OK.

6. View the alerts of the other associated tests.

In the test plan tree, view the alerts of the following tests: Itinerary > Itinerary Page and
Itinerary > View Reservations > Review Reservations.

Creating Follow Up Alerts
ALM enables you to add your own alerts to remind you to follow up on outstanding issues. In this
exercise, you will add a follow-up flag to a defect whose status you want to check one week from
today.

When you add a follow-up flag, ALM also adds an information bar that reminds you about the follow-
up alert. When the follow-up date arrives, ALM sends you an email reminder, and changes the flag
icon from gray to red.

Follow-up flags are specific to your user name, meaning that only you can see your follow-up alerts.

To create a follow up alert:

1. Display the Defects module.

On the ALM sidebar, select Defects.

2. Select the defect that you want to flag with a follow up reminder.

In the Defects Grid, select a defect.

3. Create the follow up alert.

a. Click the Flag for Follow Up button. The Flag For Follow Up dialog box opens.
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b. Perform the following:

Follow up by:Select the date one week from today.

Description: Type: Remindme about this defect on this date.

c. Click OK. The flag icon is added to the defect record.
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Chapter 8: Analyzing ALM Data
HP Application Lifecycle Management (ALM) reports and graphs help you assess your application
lifecycle management process. You can generate reports and graphs at any time during the
process.

Project reports enable you to design and generate versatile reports containing information from the
ALM project.

You can create graphs or project reports either in the Analysis View module, or during your work in
the Requirements, Test Plan, Test Lab, Business Components, or Defects modules. In either
case, you can save the graphs and reports in the Analysis View module for future reference.

Using the Dashboard View module, you can also create dashboard pages that display multiple
graphs side-by-side.

In this lesson, you will learn about:

Generating Project Reports 131

Generating Graphs 136

Generating Entity Graphs in the Analysis View Module 136

Generating Business View Graphs in the Analysis View Module 141

Generating PredefinedGraphs 146

Sharing Graphs 147

Generating Business View Excel Reports 149

Generating Dashboard Pages 154
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Generating Project Reports
Project reports enable you to compile versatile reports of project data.

In a project report, you define sections and sub-sections, each listing records of a specified ALM
entity.

To each report section, you assign a template that determines the fields and layout of the section.
You also assign document and style templates that determine the overall report appearance.

In this exercise, you will create a report of tests with their linked defects.

To generate a project report:

1. Open the ALM_Demo project.

If theALM_Demo project is not already open, log in to the project. For more information, see
"Starting ALM" on page 17.

2. Display the Analysis View module.

On the ALM sidebar, underDashboard, select Analysis View.

3. Add a folder to the Private root folder.

a. In the tree, select thePrivate folder.

b. Click theNew Folder button. The New Folder dialog box opens.

c. Under Folder Name, typeMy_Analysis_Items.

d. Click OK. The new folder is added as a sub-folder of the Private folder. The Details tab
displays the folder name and the user who created the folder.

e. In theDescription tab, type This folder includes my demo analysis items.

4. Create a project report.

a. Click theNew Item button and select New Project Report. The New Project Report
dialog box opens.

b. In theProject Report Name box, type Reviewed tests and linked defects.

c. Click OK. A new project report is added to the folder you created. Notice that the icon
represents a project report.
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The Configuration tab is selected.

5. Add amain section to report.

a. Click theAdd Report Section button. The Add Report Section dialog box opens.

b. Under Type, select Tests. The default section name Tests displays in theName field.

c. Click OK. The Tests section is added to the report tree, under theDocument root folder.

6. Add a sub-section to the report.

a. In the report tree, right-click the Tests section, and select Add Report Section.

In the Add Report Section dialog box, you can select an entity related to themain section.

b. Under Type, select Defects. TheRelationship field describes the nature of the
relationship between the tests and defects. The default section name Linked Defects
displays in theName field.
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c. Click OK. The Linked Defects section is added to the report tree, under the Tests section.

7. Configure document settings.

a. In the report tree, select theDocument root node.

b. In the right pane, in theOutput Format field, select PDF.

c. UnderDocument Templates, you assign templates that affect different areas of the
report.

Template
Type Description

Document
Template

Defines fields on the title page, headers and footers, page orientation,
and other document layout settings.
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Template
Type Description

Style
Template

Defines formatting of report elements. For example, tables, headings,
and paragraphs.

History
Template

Defines the style in which history information is displayed in report
sections.

Default templates are assigned to the different template types. Additional templates can be
designed by the project administrator in Project Customization.

d. Click theEdit Document Field Values button alongside the Document Template field.
The Edit Document Template Field Values dialog box opens.

The dialog box enables you to type values for fields in areas such as the title page, headers
and footers, as defined in the document template.

e. For each field name, type the following values:

Field Name Field Value

Project ALM Demo Project

Title1 Interim Report

summary An interim report of reviewed tests and their linked defects.

Author Alex ALM

f. Click OK.
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8. Configure the Tests report section.

a. In the report tree, select the Tests section.

b. UnderReport Section Details, in theName field, rename the section Reviewed Tests.
The section name is used as the section title in the report.

c. Under Template Details, make sureProject Template is selected.

d. Click the arrow, and select Test Template created by Alice. The template you assign to
the section determines the section format, and the entity fields displayed in the section.

e. Under Filter, click theSet Filter/Sort button. The Filter Tests dialog box opens.

f. Click the arrow adjacent to theReviewed field.

g. In the Select Filter Condition dialog box, select Reviewed, and click OK.

h. Click OK to close the Filter Tests dialog box.

9. Configure the Linked Tests report section.

a. Select the Linked Defects section.

b. Click the arrow alongsideProject Template, and select Defect Tabular Template.
Tabular templates display records in rows of a table.

10. Generate the report.

Click Generate. A dialog box opens, displaying the progress of the report generation.

When the report is ready, a PDF reader opens, displaying the report results.
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Generating Graphs
You can create graphs in the Analysis View module, that display data from the Requirements, Test
Plan, Test Lab, Business Components, and Defects modules. You can also create predefined
graphs directly from the Requirements, Test Plan, Test Lab, Business Components, and Defects
modules. In either case, you can use a graph wizard to guide you through the stages of creating a
graph.

You can create two types of graphs, entity graphs or business view graphs. Entity graphs display
data directly from the various modules. Business view graphs are based on project entities, and
ensure that only information that is relevant to a business consumer is contained in the graph.

After creating a graph, you can share the graph for viewing in aWeb browser outside ALM.

This section includes:

Generating Entity Graphs in the Analysis View Module 136

Generating Business View Graphs in the Analysis View Module 141

Generating PredefinedGraphs 146

Sharing Graphs 147

Generating Entity Graphs in the Analysis View
Module

In the Analysis View module, you can create graphs and configure them according to your
specifications. You can also create a graph using the graph wizard. The graph wizard takes you
through the steps involved in creating a graph and defining its settings.

You create graphs in either a public folder or a private folder. Graphs in a public folder are
accessible to all users. Graphs in a private folder are accessible only to the user who created them.

In this exercise, you will use the graph wizard to generate an entity graph that summarizes the
defects by status and priority level.

To generate an entity graph in the Analysis View module:

1. Make sure the Analysis View module is displayed.

If the Analysis View module is not displayed, on the ALM sidebar, underDashboard, select
Analysis View.

2. Open the graph wizard.

Click theNew Item button and select Graph Wizard. The graph wizard opens to the Select
Graph Type page.
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3. Select the graph type.

Select Entity Graph.

4. Select the entity type.

a. Click Next. The Select Entity Type page opens.

b. UnderEntity, select Defects.

c. UnderGraph Type, make sureSummary Graph is selected.

5. Select the projects to include.

Note: If you are using HP ALM Essentials Edition, ignore this step.
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a. Click Next. The Select Projects page opens.

b. You can include data frommultiple projects in the graph. For this exercise, we will use only
the current project. Make sureUse Current Project is selected.

6. Define a filter to view defects with high to urgent priority.

a. Click Next. The Select Filter page opens.

b. Under Filter Selection, select Define a new filter. Click the Filter button. The Filter
defects dialog box opens.

c. Click the down arrow adjacent to thePriority field. The Select Filter Condition dialog box
opens.

d. In the right pane, select the logical expression >=.

e. In the left pane, select 3-High. The condition appears as follows:

f. Click OK to close the Select Filter Condition dialog box.

HP ALM (11.52)Page 138 of 184

Tutorial
Chapter 8: Analyzing ALM Data



7. Define a filter to view defects that are not closed.

a. Click the down arrow adjacent to theStatus field. The Select Filter Condition dialog box
opens.

b. In the right pane, select the logical expressionNot.

c. In the left pane, select Closed. The condition appears as follows:

d. Click OK to close the Select Filter Condition dialog box.

e. Click OK to close the Filter defects dialog box.

8. Set the graph attributes.

a. Click Next. The Select Graph Attributes page opens.

b. UnderGroup By field, make sure that it is set to <None>.

c. UnderX-axis field, select Priority to view the number of defects by priority.

9. Generate the Graph.

Click Finish. The graph is displayed in the graph window.
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The graph shows a summary of defects withHigh toUrgent priority, whose status is not
Closed.

10. Save the graph in the Analysis View module.

a. Click Add to Analysis Tree. The New Graph dialog box opens.

b. Expand thePrivate folder, and selectMy_Analysis_Items.

c. Click Save. The Defects Summary graph is saved in the analysis tree, and displayed in the
View tab.

11. Display additional defect details.
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a. Click a bar in the graph. The Drill DownResults dialog box opens and displays the defects
that belong to the bar.

b. Close the Drill DownResults dialog box.

12. Display other graph views.

a. Click thePie Chart button to display the graph as a pie chart.

b. Click theData Grid button to display the data as a grid.

Generating Business View Graphs in the Analysis
View Module

In this exercise, you will use the graph wizard to generate a business view graph that summarizes
the defects by status and priority level.

To generate a business view graph in the Analysis View module:

1. Make sure the Analysis View module is displayed.

If the Analysis View module is not displayed, on the ALM sidebar, underDashboard, select
Analysis View.

2. Open the graph wizard.

Click theNew Item button and select Graph Wizard. The graph wizard opens to the Select
Graph Type page.
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3. Select the graph type.

Select Business View Graph.

4. Select the business view.

a. Click Next. The Select Business View page opens.

b. Select Requirements.

5. Select the projects to include.

Note: If you are using HP ALM Essentials Edition, ignore this step.
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a. Click Next. The Select Projects page opens.

b. You can include data frommultiple projects in the graph. For this exercise, we will use only
the current project. Make sureUse Current Project is selected.

6. Define a filter to view requirements with high to urgent priority.

a. Click Next. The Select Filter page opens.

b. Click the down arrow in the Criteria column adjacent to thePriority field. The Select Filter
Condition dialog box opens.

c. In the right pane, select the logical expression >=.

d. In the left pane, select 3-High. The condition appears as follows:

e. Click OK to close the Select Filter Condition dialog box.

7. Define a filter to view defects that are not closed.
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a. Click the down arrow in the Criteria column adjacent to theReviewed field. The Select
Filter Condition dialog box opens.

b. In the left pane, select No Reviewed. The condition appears as follows:

c. Click OK to close the Select Filter Condition dialog box.

8. Set the graph attributes.

a. Click Next. The Select Graph Attributes page opens.

b. UnderX-axis, select Priority and under Y-axis, select Count to view the number of
requirements by priority.

c. UnderGrouped By, make sure that it is set to <None>.

9. Generate the Graph.

Click Finish. The graph is displayed in the graph window.
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The graph shows a summary of requirements withHigh toUrgent priority that have not been
reviewed.

10. Save the graph in the Analysis View module.
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a. Click Add to Analysis Tree. The New Business View Graph dialog box opens.

b. Expand thePrivate folder, and selectMy_Analysis_Items.

c. Click Save. The Requirements graph is saved in the analysis tree, and displayed in the
View tab.

11. Display other graph views.

a. Click thePie Chart button to display the graph as a pie chart.

b. Click theData Grid button to display the data as a grid.

Generating Predefined Graphs
You can create predefined graphs during your work in the Requirements, Test Plan, Test Lab,
Business Components, and Defects modules. Predefined graphs enable you to create several
types of graphs in eachmodule, using the existingmodule filter. You can use predefined graphs for
one-time reference, or save them in the Analysis View module, where you can continue to configure
their data and appearance.

In this exercise, you will generate a summary graph from the Defects module.

To generate a predefined graph:

1. Display the Defects module.

On the ALM sidebar, select Defects.

2. Clear the Defects grid filter.
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Click theSet Filter/Sort arrow, and chooseClear Filter/Sort to clear the filter that is applied
to the grid.

3. Generate a report.

ChooseAnalysis > Graphs > Defects Summary - Group by Status. The graph window
opens, displaying the selected graph.

The graph shows the number of defects that exist in your project, according to the people to
whom they are assigned. Defects in the graph’s columns are grouped according to their status.

4. Close the graph window.

Click theCancel button.

Sharing Graphs
You can allow ALM users or others to view read-only versions of graphs outside ALM. Each time
you access the graph outside ALM, it displays themost up-to-date information.

In this exercise, you will share the Defects Summary graph you created in the Generating Entity
Graphs in the Analysis View Module exercise.

To share a graph:

1. Display the Analysis View module.

On the ALM sidebar, underDashboard, select Analysis View.

2. Share the Defects Summary graph.
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a. In thePrivate folder, underMy_Analysis_Items, select Defects Summary Graph -
Group by ‘Priority’.

b. Right-click and select Share Analysis Item. The Share Analysis Item dialog box opens.

c. Select Copy Analysis Item Public URL. This option allows others to view the graph
without entering ALM user credentials.

d. Click OK. A URL of the graph is saved to the clipboard.

3. View the graph outside ALM.

a. Open aWeb browser window.

b. In the address bar, paste the clipboard content, and press ENTER. The graph is displayed
in theWeb browser.
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Below the graph, the Last Generated date and time is displayed, and a link to the item in
ALM.

Generating Business View Excel Reports
You can create Excel reports based on business views. A business view is a data layer that exists
on top of the database and which reflects only those project entity fields that represent information
that is useful from a business perspective. Business views can be based on single entities, such an
Baselines or Defects, while others can represent more complex relationships between entities,
such as Defects With Linked Requirements.The reports are created and configured inMicrosoft
Excel, and uploaded to the Analysis View module.

In this exercise, you will useMicrosoft Excel to generate a business view Excel report that
summarizes the defects by status and priority level.

Note: The HP ALM Business Views Microsoft Excel Add-in supports only Microsoft Excel
2007 andMicrosoft Excel 2010 (32-bit). If you are using a different version of Microsoft Excel,
proceed to "Generating Dashboard Pages" on page 154.
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To generate a business view Excel report in the Analysis View module:

1. Make sure the Analysis View module is displayed.

If the Analysis View module is not displayed, on the ALM sidebar, underDashboard, select
Analysis View.

2. Create a new business view Excel report.

a. In thePrivate folder, select theMy_Analysis_Items folder.

b. Click theNew Item button and select New Business View Excel Report. The New
Business View Excel Report dialog box opens.

c. In theBusiness View Excel Report Name box, type High Priority Open Defects.

d. Click OK. A new business view Excel report is added to the folder you created. Notice that
the icon represents a business view Excel report.

The Configuration tab is selected.

3. Open Excel.

a. Click Install Addin. The HP ALM Business Views Microsoft Excel Add-in is installed in
Excel.

b. Click New Excel. Microsoft Excel opens with the HP ALM tab in the ribbon.

c. In theHP ALM tab, click Login. The ALM login window opens. Log in exactly as you
logged in to ALM at the beginning of the tutorial.

4. Generate the business view report in Excel.
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a. Click Add. The AddWorksheet dialog box opens.

b. Select Defects.

c. Click OK. A new business view Excel worksheet is added and theWorksheet
Configuration pane is opened.
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5. Configure the business view report.

a. In the Filter tab, select Priority in the Field Name column.

b. In the associatedCriteria column, click the arrow. The Select Filter Condition dialog box
opens.

c. Click 4-Very High, Or, and 5-Urgent.

d. Click OK.

e. Select Status in the Field Name column.

f. In the associatedCriteria column, click the arrow. The Select Filter Condition dialog box
opens.

g. Click Not, Closed, And, Not, andRejected.

h. Click OK. The business view Excel report shows only those defects whose priority is Very
High orUrgent and whose status is not Closed and not Rejected.

6. Save the new report in ALM.

a. Click Save and select Save to ALM. The Save Business View Excel Report dialog box
opens.

b. In the Select Folder box, browse to theMy_Analysis_Items folder and select the High
Priority Open Defects report. The Business View Excel Report Name box is automatically
valued with High Priority Open Defects.

c. Click Save.

d. Click Yes in the Replace Confirm message. The report is saved to ALM.
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7. Generate the report in ALM.

a. Return to the Analysis View module in ALM.

b. Click Refresh. The High Priority Open Defects report is selected with the Configuration tab
open.

c. Click Generate. The Download Excel File dialog box opens.

d. Browse to the location on your client machine where you want to save the Excel report,
enter High Priority Open Defects in the File name field, and click Save.

The report opens in Excel with the latest data included.

Generating Dashboard Pages
Using the Dashboardmodule, you can arrange and view multiple graphs on a single dashboard
page. You select the graphs to include in the dashboard page from the graphs in the analysis tree.
You can arrange and resize the graphs on the page.

You create dashboard pages in either a public folder or a private folder. Dashboard pages in a
public folder are accessible to all users. Dashboard pages in a private folder are accessible only to
the user who created them.

In this exercise, you will create a dashboard page for the defect graphs in the public folder.

To generate a dashboard page:

1. Display the Dashboard View module.

On the ALM sidebar, underDashboard, select Dashboard View.

2. Add a page to the Public folder.

a. In the tree, select thePublic folder.

b. Click theNew Page button. The New Dashboard Page dialog boxopens.

c. In theDashboard Page Name field, type Summary of Defects page.

d. Click OK.A dashboard page is added to the dashboard tree under the Public folder.

3. Select the graphs that you want to include in the dashboard page.

a. Click theConfiguration tab.

b. In the Graphs Tree pane, expand thePublic folder.

c. Expand theDefects folder. The folder includes four graphs.
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d. Double-click the first graph. A placeholder for the graph is created in the Configuration tab
displaying the graph’s title.

e. Add the other three graphs to the dashboard page.

4. Rearrange the dashboard page.

a. Select the second placeholder and drag it upwards so that it is alongside the first
placeholder.
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b. Select the fourth placeholder and drag it upwards so that it is alongside the third
placeholder.

5. View the dashboard page.

a. Click theView tab. ALM generates and displays the graphs in the View tab.

The dashboard page displays the unresolved defects per cycle, per person, per severity,
and per subject.

b. To view the dashboard page in full-screenmode, click theView Page in Full Screen
button, located in the upper-right corner of the page.
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c. To return to the standard view, click theClose button, located in the upper-right corner of
the page.
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Chapter 9: Creating Libraries and
Baselines

A library represents a set of entities in a project and the relationships between them. The entities in
a library can include requirements, tests, test resources, and business components. A baseline is a
snapshot of the library at a specific point in time. Baselines enable you to keep track of changes
made to your project over time.

You create libraries in the Libraries module.

You can compare baselines at all stages of the application lifecycle management process. For
example, you can compare two baselines in a library to review changes made to tests in the library
over time. You can also compare a baseline to the current entities in the library.

In this lesson, you will create a library of tests and requirements. You will then compare two
baselines in the library to review changes made to tests in the library over time.

Note: This lesson is not available for HP ALM Essentials Edition.

In this lesson, you will learn about:

Creating Libraries 159

Creating Baselines 160

Comparing Baselines 162
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Creating Libraries
In this exercise, you will add a library of tests and requirements to ALM. To perform this exercise
youmust log in as alex_alm.

To create a library:

1. Make sure to log in to ALM_Demo as alex_alm.

Open the HP ALM Login window. In the Login Name box, type alex_alm. Skip thePassword
box.

For more information, see "Starting ALM" on page 17.

2. Display the Libraries module.

On the ALM sidebar, underManagement, select Libraries.

3. Create a library folder.

a. In the libraries tree, select the root Libraries folder. Click theNew Folder button. The New
Library Folder dialog box opens.

b. In the Library Folder Name box, type Folder1.

c. Click OK. The Folder1 folder is added to the libraries tree.

d. In theDescription box in the right pane, type the following description for the library folder:
This folder contains a library of tests and requirements.

4. Add a library to your library folder.

a. Click theCreate Library button. The New Library dialog box opens on the Content page.
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b. In theName box, type Library1.

c. In theRequirements tab, expand theRequirements root folder. Select the check box
adjacent to theMercury Tours Application folder, to include the folder in the library.

d. Click the Tests tab. Make sure the Tests in selected folders option is selected. Expand
theSubject root folder, and select theMercury Tours Site folder to include in the library.

e. Click Details on the sidebar. In theDescription box, type This library includes tests and
requirements.

f. Click OK. The new library is added to the libraries tree.

Creating Baselines
A baseline is a snapshot of your library at a specific point in time. You can use a baseline tomark
any significant milestone in the application lifecycle management process. A baseline includes all
the entities defined in the library, including requirements, tests, test resources, and business
components. Baselines also include the relationships between the entities in the library, such as
traceability and coverage. Baselines enable you to keep track of changes made to your project over
time.

In the following exercise, you will create an initial baseline that will later be compared to another
baseline to evaluate the impact of changes.

To create a baseline:

1. Make sure the Libraries module is displayed.

If the Libraries module is not displayed, on the ALM sidebar, underManagement, select
Libraries.

2. Add a baseline to your library.

a. In the libraries tree, select the Library1 library.

b. Click theCreate Baseline button. The Baseline Verification dialog box opens, and a
verification process begins.
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The Verification results window displays the results of the library size verification. The
process checks that the size of the library does not exceed the limit defined in Site
Administration.

c. Click Continue. The New Baseline dialog box opens.

d. In theBaseline Name field, type Baseline1. Click OK. The baseline is added to the
libraries tree, and the creation process begins.

The baseline is created in a background process, andmay take some time. You can
continue working in ALM during the baseline creation process.

e. In the Details tab, click theDescription pane and type Baseline of tests and requirements.

3. View the baseline log file.

In the Details tab, click theView Log button. The Log: Create Baseline dialog box opens and
displays the progress. Click Close to close the dialog box.

TheView Log button is no longer displayed.
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Comparing Baselines
You can compare two baselines in a library. For example, you can compare baselines at different
stages of development to assess the impact of changes made to requirements in your project. You
can then update the relevant tests in your project accordingly.

You can also compare a baseline to the current entities in the library. For example, suppose you
create a baseline at the start of a new release. Over time, changes aremade to requirements in the
library. To determine whether product development is proceeding as planned, you can compare
requirements in the initial baseline with the current requirements in the library.

In the following exercise, you will add test coverage to a requirement and then create another
baseline. You will then compare your two baselines to evaluate the impact of the changes.

To compare baselines:

1. Modify a requirement.

a. On the ALM sidebar, underRequirements, select Requirements.

b. Select View > Requirement Details.

c. In the requirements tree, underMercury Tours Application, expandApplication
Usability. Select Keyboard Support.

d. Click the Test Coverage tab. The Test Coverage tab displays coverage for this
requirement.

e. If the Test Plan Tree tab on the right is not displayed, click theSelect Tests button.

f. In the Test Plan Tree tab, expand theMercury Tours Site andHTML Pages subject
folders.

g. Double-click theHTML Page Source test. The test is added to the coverage grid.

2. Create a new baseline.

Repeat Steps 1 and 2 in "Creating Baselines" on page 160. Name your new baseline
Baseline2.

3. Select a baseline with which to compare.

a. In the libraries tree, select Baseline1. Click theCompare To button, and select Select
Baseline to compare the baseline with another baseline. The Select Baseline dialog box
opens.

b. Click the arrow and select Baseline2 from the list. Click OK.

c. Click OK to close the Select Baseline dialog box. Click Yes to close theWarning dialog
box. The Compare Baselines Tool dialog box opens.
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The baselines are displayed in separate panes, with themore recently created baseline
displayed in the right pane. In each pane, the library’s entities are displayed in the same
hierarchical tree structure as defined in the specific module.

4. View requirement changes between the baselines.

a. Click theGo To Next Change button in the right pane to view the change.

Differences between the two baselines are indicated in theChanges column. The tool
indicates that there is a difference in theKeyboard Support requirement between the
baselines.

b. To compare themodified requirement between baselines, select Keyboard Support and
click theCompare Entities button on the toolbar. The Compare Entities dialog box opens.

c. Click the Test Coverage button on the sidebar.
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The Test Coverage view displays details of the entity in each baseline.

d. Click Close.
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Chapter 10: Customizing Projects
In the previous lessons, you learned how to use HP Application Lifecycle Management (ALM) to
help youmanage all phases of the application lifecycle management process, including specifying
releases and cycles, specifying requirements, planning tests, running tests, and tracking defects.

In this lesson, you will learn how to customize your ALM project to meet the needs of your team.
You can control access to a project by defining the users who can access the project and by
specifying the types of tasks each user can perform. When new members are added to your team,
you assign them to the projects that they will be using, and specify the tasks that they can perform.

You can also customize your ALM project by modifying system fields or by adding user-defined
fields. System fields are ALM default fields. You cannot add or delete system fields, you can only
modify them. User fields are fields that you can define. You can add, modify, and delete user-
defined fields.

Fields can be associated with system and user-defined lists. A list contains the values that the user
can enter in a field. For example, if you are running tests on two different database servers, you can
add aDatabase field to your project. You can then create a selection list containing the values
Oracle andMicrosoft SQL, and associate the list with theDatabase field.

In this lesson, you will learn about:

Starting Project Customization 167

Adding a New Project User 169

Assigning a User to a User Group 171

Defining a User-Defined Field 173

Creating a Project List 175

Creating Business Views 179
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Starting Project Customization
You customize your ALM projects using the Project Customization window. In this exercise, you
will log in to the Project Customization window with project administrator privileges.

To start project customization:

1. Open the HP ALM Login window.

Make sure that the ALM Login window is open. For more information, see "Starting ALM" on
page 17.

2. Type a user namewith project administrator privileges and authenticate.

a. In the Login Name box, type alex_alm.

b. Skip thePassword box. A password was not assigned to this user name.

c. Click theAuthenticate button. ALM verifies your user name and password and determines
which domains and projects you can access.

3. Log in to the project.

a. In theDomain list, select Default.

b. In theProject list, select ALM_Demo.

c. Click the Login button.

The ALMmain window opens and displays themodule in which you were last working.

4. Open the Project Customization window.

a. Choose Tools > Customize on the ALMmasthead. The Project Customization window
opens.

By default, the Project Customization window contains the following links:
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Option Description

User
Properties

Enables you to change your user properties. For example, you can
change your email address. You can also change your password.

Project
Users

Enables you to add and remove users from an ALM project. You can also
assign users to user groups to restrict user access privileges.

Groups and
Permissions

Enables you to assign privileges to user groups by specifying permission
settings.

Module
Access

Enables you to control themodules that each user group can access. By
preventing users from accessing unnecessary modules, you can better
utilize your ALM licenses.

Project
Entities

Enables you tomodify the behavior of ALM system fields or define user-
defined fields that are unique to your project. For example, if you are
running tests on several builds of an application, you can add aDetected
in Build user-defined field to the New Defect dialog box. You can then
associate it with a selection list containing the values for this field.

Requirement
Types

Enables you to customize the definitions for requirement types.

ALM Editions: This option is not available for HP ALM Essentials
Edition.

Risk-Based
Quality
Management

Enables you to customize settings for risk-based quality management.

ALM Editions: This option is not available for HP ALM Essentials
Edition.

Project Lists Enables you to add customized lists to a project. A list contains values
that the user can enter in system or user-defined fields. For example, for
theDetected in Build field, you can create a selection list containing the
values Build1, Build2, andBuild3.

Automail Enables you to set up automatic mail notification rules to inform users via
email each time changes aremade to specified defects.

Alert Rules Enables you to activate alert rules for your project. This instructs ALM to
create alerts and send emails when changes occur in the project.

Workflow Enables you to generate scripts that perform commonly needed
customizations on dialog box fields in the Defects module. In addition,
you can write scripts to customize dialog boxes in other modules, and
control the actions that users can perform.

Project
Planning and
Tracking

Enables you to create and customize the project planning and tracking
(PPT) KPIs.

ALM Editions: The Project Planning and Tracking link in Project
Customization is not available for HP ALM Essentials Edition and HP
Quality Center Enterprise Edition.
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Option Description

Project
Report
Templates

Enables you to create and customize report templates that project users
can assign to template based reports.

Business
Process
Testing

Enables you to configure Business Process Testing and Business
Process Testing Enterprise Edition.

Business
Views

Enables you to create business views that can be used as a basis for
creating reports in the Analysis View module.

Sprinter Enables you to configure settings for working with HP Sprinter for
manual testing in ALM.

ALM Editions: The Sprinter link in Project Customization is not
available for HP ALM Essentials Edition and Performance Center
Edition.

Adding a New Project User
You can control access to an ALM project by defining the users who can log in to the project, and by
specifying the types of tasks each user may perform.

For each project, you select project users from the ALM site users list. This list is created in Site
Administration.

From Project Customization, you add users to a project and assign them to user groups. Each user
group has access to certain ALM tasks.

In this exercise, you will add a new project user to the ALM_Demo project.

Note: For the purpose of the exercise, we will first remove a user from the project, and then
add the user to the project again.

To add a new project user:

1. Make sure that you are logged in to ALM as a project administrator.

For more information on how to open the Project Customization window, see "Starting Project
Customization" on page 167.

2. Open the Project Users page.

In the Project Customization window, click theProject Users link. The Project Users page
opens and displays a list of users that have been assigned to the project.
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3. Remove a user.

In the Project Users list, select cecil_alm, and click Remove User. Click Yes to confirm.

4. Add a new user name.

a. Click theAdd User down arrow.

You can add an existing user from the list of site users by typing the user’s name or by
selecting the user from the list of site users. You can also create a new user and add the
new user to the project.

b. Select Add User by Name. The Add User dialog box opens.

c. In theUser Name box, type cecil_alm and click OK.

The new user is added to the Project Users list and the user properties are displayed in the
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Details tab. User personal settings are defined in Site Administration.

Assigning a User to a User Group
To enable users to do their job, and to protect a project from unauthorized access, ALM enables you
to assign each user to a specific user group. Each group has access to certain ALM tasks. You can
use the predefined user groups with their default permissions or you can customize your own user
groups with unique sets of permissions.

In this exercise, you will assign the new user cecil_alm to the QATester user group.

To assign a user to a user group:

1. Make sure that the Project Users page is displayed.

If the Project Users page is not already open, click theProject Users link in the Project
Customization window.

HP ALM (11.52)Page 171 of 184

Tutorial
Chapter 10: Customizing Projects



2. Select cecil_alm from the Project Users list.

In theProject Users list, select cecil_alm.

3. Display user’s membership in user groups.

Click theMembership tab. The user groups to which cecil_alm belongs and does not belong
are displayed.

4. Assign cecil_alm to the QATester group.
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UnderNot Member of, select QATester and click the right arrow button tomove the group to
Member of.

5. Remove cecil_alm from the Viewer group.

a. UnderMember of, select Viewer and click the left arrow button tomove the group toNot
Member of.

b. Click Save to save the changes to the Project Users page. Click OK.

Defining a User-Defined Field
You can define user-defined fields that are unique to your project, or modify the behavior of ALM
system fields.

The fields are stored in ALM project entities. For example, the Defect entity contains data entered in
the Defects module.

In the following exercise, you will add theDatabase user-defined field to theDefect entity. This field
indicates the server database in use when testing an application.

To add a user-defined field:

1. Make sure that the Project Customization window is displayed.

For more information on how to open the Project Customization window, see "Starting Project
Customization" on page 167.

2. Open the Project Entities page.

In the Project Customization window, click theProject Entities link. The Project Entities page
opens.
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3. Add a new user-defined field to the Defect entity.

a. UnderProject Entities, expandDefect.

b. Click theUser Fields folder and click theNew Field button. A new field is added under the
User Fields folder.

HP ALM (11.52)Page 174 of 184

Tutorial
Chapter 10: Customizing Projects



BG_USER_nn indicates a user-defined field under the Defect entity.

4. Rename the default field name.

a. In the Label box, instead of the default name, type Database.

b. Click Save.

c. Click OK.

Creating a Project List
You can associate fields with system and user-defined lists. A list contains values that the user can
enter in a field.

In the previous exercise you added the Database field. In the following exercise you will create a list
and assign it to the Database field. You will then open the New Defect dialog box to view the new
field.

To create a project list:

1. Make sure that the Project Customization window is displayed.

For more information on how to open the Project Customization window, see "Starting Project
Customization" on page 167.

2. Open the Project Lists page.

In the Project Customization window, click theProject Lists link. The Project Lists page
opens.
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3. Create a new list.

a. Click New List. The New List dialog box opens.

b. In the List Name box, type DB. Click OK to close the New List dialog box.

4. Add Items to your list.

a. Click New Item. The New Item dialog box opens. TypeOracle and click OK.

b. Repeat the same procedure and addMS SQL to the DB list.

HP ALM (11.52)Page 176 of 184

Tutorial
Chapter 10: Customizing Projects



c. Click Save to save the changes to the Project Lists page. Click OK.

5. Assign the list to the Database field.

a. In the Project Customization window, click theProject Entities link. The Project Entities
page opens.

b. UnderProject Entities, expandDefect.

c. Expand theUser Fields folder and select Database.

d. UnderSettings, in the Type list, select Lookup List to set the field type as a drop-down
list. The Lookup list section is displayed below the field settings.
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e. Under Lookup List, select theDB list.

f. Click Save to save the changes to the Project Entities page. Click OK.

6. View the new user-defined field in the New Defect dialog box.

a. Click theReturn button located on the upper-right corner of the window.

b. In the Customization Changes dialog box, selectMajor Change, and click OK. The
Project Customization window closes, and you return to your ALM project.

c. In the Defects module, click theNew Defect button. The New Defect dialog box opens.
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TheDatabase field is displayed in the New Defect dialog box. Youmay need to drag the
scroll bar down to display the field.

d. Click the down arrow and view the database types you defined. Click Close.

Creating Business Views
Business views are a semantic data layer that can be used as a basis for the various Application
Lifecycle Management (ALM) reporting tools. Business views are based on project entities, and
ensure that only information that is relevant to a business consumer is contained in the report.

In the following exercise you will create a business view for creating graph reports.

To create a business view:

1. Make sure that the Project Customization window is displayed.

For more information on how to open the Project Customization window, see "Starting Project
Customization" on page 167.

2. Open the Business Views page.

In the Project Customization window, click theBusiness Views link. The Business Views
page opens.

3. Create a new business view.

a. Click Add View. The New View dialog box opens.

b. In the Label box, typeMercury Tour Defects. In the Technical Name box, typeMT_
Defects. Click OK to close the New View dialog box.
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4. Add project entities to your business view.

a. Click Add Entity in the Query Designer tab. TheModel tree opens in the right pane. The
Model tree displays all project entities and fields in the current project.

b. Select theDefect entity and click theAdd arrow tomove it to theMain pane.

5. Define relationships between the project entities.

a. In theMain pane, select theDefect entity.

b. Click Add Related Entity. The Add Related Entity dialog box opens.

c. In Target Entity, click the arrow and select Requirement. TheRelation Name field is
automatically valued with Linked Requirements.

d. Click OK.

6. Preview the new business view.

a. Click Validate. Any validation warning or error messages are shown in the bottom pane.

b. Click Preview. TheQuery Results are shown in the bottom pane.

c. Change theStatus to Published.

d. Click Save.
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Chapter 11: Conclusion
ALM helps you organize andmanage all phases of the application lifecycle management process,
including defining releases, specifying requirements, planning tests, executing tests, and tracking
defects. Throughout each phase, you can analyze data by generating detailed reports and graphs.

Phase Description

Release
Specifications

Develop a release-cycle management plan to help youmanage application
releases and cycles efficiently. You can track the progress of an application
release against your plan to determine whether your release is on track.

Requirement
Specifications

Define requirements tomeet your business and testing needs. You canmanage
the requirements and conduct multi-dimensional traceability between
requirements, tests and defects, across multiple releases and cycles. ALM
provides real-time visibility of requirements coverage and associated defects to
evaluate quality and business risk.

Test Planning Based on the project requirements, you can build test plans and design tests.
ALM provides a repository for bothmanual and automated tests.

Test
Execution

Create a subset of the tests in your project designed to achieve specific test
goals. ALM supports sanity, functional, regression, and advanced testing.
Execute scheduled tests to diagnose and resolve problems.

Defect
Tracking

Submit defects and track their repair progress. Analyzing defects and defect
trends helps youmake effective “go/no go” decisions. ALM supports the entire
defect lifecycle— from initial problem detection through fixing the defect and
verifying the fix.
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